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Image Alchemy? The name was chosen to honor the memory of mediaeval
alchemists who sought to convert lead into gold.  True to their
spirit, Image Alchemy provides the catalyst for converting
images into profit.

Image Alchemy can take small images, scale them up, and
output them to wide format printers and plotters. Image
Alchemy can take large images and scale them down for
presentation on web pages. Image Alchemy provides an easy to
learn interface for doing these kinds of jobs with individual files
or hundreds, thousands, even millions of files.

Image Alchemy batch processes images.  Scripts to perform
repetitive graphics processing, manipulation and translation jobs
can be easily recorded.

Image Alchemy automatically recognizes 88 different bit-
mapped graphics and animation formats including all their color
space and compression variations.

Simple chores  such as creating the best palette for a series of
images, and then mapping all the images to it, can be performed
without any need for scripting.

Sophisticated scripts can perform any combination of batch
scanning, converting, ICC color matching, dithering, printing
and archiving with the click of a mouse.

Please call Customer Support and let us help you get the most
out of Image Alchemy.  Telephone (510) 252-0101 from 8:30 am
to 5:00 pm Pacific Time.  Or email support@handmade.com.

Your questions and comments are very important to us and we
appreciate hearing from you.

2          Image Alchemy



1

Installing Image Alchemy

Overview Installation of Image Alchemy is straightforward; it involves
running the Image Alchemy Installer on the floppy disk.

Required
equipment

At a minimum you must have the following hardware and
software to run Image Alchemy.

Any 68020/68030/68040 or PowerPC based Macintosh with at
least 8MB of RAM.

Computer

Alchemy sometimes uses space on your hard drive while
converting images.  You should have at least 4 times as much
disk space available as the image you are converting.  This is
calculated in the following way:  a 640x480 full color image
requires 640x480x3(bytes per pixel), or about 1MB.  So to
convert that image requires, at the most, about 4MB of disk
space.

Disk space

Mac OS version 7 or later.

Applescript is necessary to use Image Alchemy’s scripting
capabilities.

ColorSync 2.0 or greater is necessary to use Image Alchemy’s
ICC color matching capabilities.

Operating system

Simply launch the "Image Alchemy Installer" by double clicking
on its icon.

Installation
instructions
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Starting Image
Alchemy

To start Image Alchemy, double click on the Alchemy icon.
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Introduction

The Manual This manual serves three purposes.  The first is to explain to you
how to use Image Alchemy to your best advantage.  The second
is to provide a basic education on the specialized topics
pertaining to image transfer.  The third is to function as a
beginning reference source for these topics.

The manual is divided into seven sections:  The Introduction,
The File Menu, The Edit Menu, The Image Menu, The Display
Menu, The Script Menu, and Appendices.

The Introduction will orient you to Image Alchemy and its
manual and includes installation.  The Appendices provide
detailed ancillary information, and references.  The Menus,
described below, explain Image Alchemy and provide enough
information for you to make reasoned choices when you
encounter any options while using Image Alchemy.
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Menus

There are five menu headings in Image Alchemy.

The File menu controls converting images (including
compression), getting information about an image, and printing.

The Edit menu contains the standard Macintosh functions of
Undo, Cut, Copy, Paste, and Clear.

The Image menu allows you to control the color palette, bit
depth, and other aspects of transferring images.

The Display menu controls displaying the image on the screen.

The Script menu controls creating scripts to automate your
Alchemy jobs.

Converting or compressing images involves using Open and
Save to go from one format to another.  Opening and Saving are
discussed in Chapter 4.

Changing color spaces involves additional decisions to obtain the
best possible output.  Color management and other topics related
to optimizing output are covered in Chapter 5.
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Images

Once you have opened an image it will appear in a window.
This window may be moved or resized by using the mouse.

Image Alchemy allows you to have multiple images open at one
time.  However, when performing various operations, such as
scaling, or saving, only the currently selected image is affected.
The currently selected image is the one with a striped title bar.

If you wish to select another image that is also open, click the
mouse button in the image display area.  This also causes the
information in any open dialogs, such as the Get Info dialog, to
be updated.
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Multiple
Operations

To preserve the best quality Alchemy performs all operations on
the original image.

Example If you load an image that is 640x480, scale it to 64x48 and then
scale it to 320x240, the results would be the same as if you had
scaled the image directly from 640x480 to 320x240.

File Format
Limitations

Some file formats have limitations. For example, PCL files are
always black and white, 1 bit per pixel.  If you save a color
image as a PCL file Alchemy will automatically perform the
operations required.

Details about each file format, including any limitations, are in
Chapter 4.
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The File Menu:  General Options

Introduction Image Alchemy has several options that control the way it
operates and displays information about a file.  These options do
not affect the conversion of the image.  They are “Get File Info”,
“Get Info for Current File”, and “Options”.
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Get File Info

Choosing Get File Info will allow you to select a file and get
information about it without opening it.  This information
includes the width, height, and resolution.

Get Info for
Current File

Choosing Get Info for Current File gets information for the
currently opened and selected image.

Options These are settings that control how Image Alchemy operates;
they are remembered between sessions.  There are four different
Options dialogs in Image Alchemy, and five in Image Alchemy
PS.

General

When this option is checked images will be displayed
automatically when they are opened. When it is not checked they
will not be automatically displayed. Turning Display Images off
will enable faster conversions.  This can be overridden for
individual images with the Display menu, discussed later.

Unchecking the “Display Image” box is recommended when
scripting conversions and when viewing is not required.

Display Images
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Default
Magnification

This option allows you to select the  initial magnification for
viewing images.

Units This option allows you to select the units that will be used to
display and change image dimensions.

Save Preview Image This option causes Alchemy to generate a thumbnail for each
saved image to use as an icon.  If Quicktime is installed, a
preview image for those programs that support them is also
produced.

Scripts

This allows you to specify the default location of your scripts.
For example, if all your scripts are kept in a folder called
Alchemy Scripts, specifying this in Scripts Directory will allow
Alchemy to open this folder whenever you select “Execute
Script” under the Script menu.

Scripts Directory

This option allows you to select a specific script to be run
whenever an image is opened.

Run Script Upon
Opening Image

Convolutions
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Convolutions
Directory

This allows you to specify the default location of your
convolutions.  For example, if all your convolutions are kept in a
folder called Alchemy Convolutions, specifying this folder will
allow Alchemy to open this folder whenever you select
“Specify” under the “Convolve...” sub menu in the Image menu.

Plug-ins

Plug-ins Directory This allows you to specify the location of your plug-ins.  For
example, if all your plug-ins are kept in a folder called Alchemy
Plug-ins, specifying this folder will cause Image Alchemy to
scan that folder for plug-ins to put in the Import and Export
menus.

Postscript (Image
Alchemy PS Only)

This allows you to specify an additional location for Image
Alchemy PS to search for PostScript type 1 fonts.  Normally,
Image Alchemy PS will search the Fonts folder located where
the Image Alchemy application is, the System fonts folder, and
the Fonts folder located where the document being opened is.
The folder specified here is also searched.

Fonts Directory
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Scan Font Files Image Alchemy PS can make use of any PostScript type 1 font.
Fonts that are designed for the Macintosh follow a naming
convention that allows Image Alchemy PS to find them based
entirely on the file names.  Fonts for other platforms do not
follow those conventions.  Image Alchemy PS needs to scan
those fonts to be able to use them.  Since this takes additional
time  and is not necessary if you are using only Macintosh fonts,
Image Alchemy PS allows you to turn font scans off.
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The File Menu:  Opening and Saving Images

Introduction The File menu handles the image file management.  The File
menu includes the functions Open Several…, Open…, Import,
Save, Save As…, Save a Copy…, and Export.

Converting or compressing images involves using one of the
Open and any of the Save options to go from one format to
another.  Opening and Saving are discussed in this chapter.

Changing color spaces might involve additional decisions to
obtain the best possible output.  Color management and other
topics related to optimizing output are covered in Chapters 7 and
8.

Opening Images Opening an image is the first step in converting it to a different
format, compressing it, or performing any of the other function
which Image Alchemy allows.
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 Open Several The Open Several command allows the user to select multiple
files for batch processing.

An image is selected with a double-click or it can be selected by
a single mouse-click, then the “Add” button pressed. The file
name then appears in the bottom box.

This process is repeated until all images which need to be
converted are added.

At this point, “Open” is selected, and the files ready for batch
processing will be displayed in a window called Various
Documents.

Anything from the Image menu, and all the enabled items in the
File and Edit menus can be performed on these files.
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 Open Dialog Box

An image is selected with a single mouse-click, then the “Open”
button pressed, or it can be double-clicked.

Alchemy will automatically determine the format of the file.
Unless Alchemy incorrectly identifies a file it is best to leave the
format selection alone.

If the image is not displayed when opened, selecting “Show
Image” under the Display menu will show the image.  If it is not
displayed because Image Alchemy is low on memory, selecting a
smaller display magnification under the Display menu may help.

NOTE:  There is a check box that controls the default for
whether or not each image is displayed upon opening.  This
check box is located in the File Menu, under the “Options” sub
menu.

Input Options If there are options when opening an image, Image Alchemy
displays them in the same dialog box.  Please consult the
individual format types for explanations of the input options.

 Import Images may also be imported from Photoshop Import/Acquire
plug-ins.  Any Import/Acquire plug-ins in the folder specified in
the Plug-ins options dialog will be listed under the Import menu.
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Saving Images Images are converted by saving them to the desired format with
the desired compression.

Conversion

The Save A Copy... dialog box allows the user the standard
Macintosh feature of renaming the file and saving it in an
appropriate location.

Save As... is similar to Save a Copy…, but after saving the
image, it replaces the current image with the one you just saved.
This means Save As… is restricted to formats that Image
Alchemy can read and write, not just write, and it is slower than
Save a Copy…
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Compression Compressing files is accomplished by selecting the relevant type
of compression in the particular image format.  Although many
formats allow compression types, there are a few which work
best most of the time.

We recommend the following choices when compressing
different bit-depth images.

For 24-bit (true color) images, if lossy compression is
acceptable, the best choice is JPEG.  If compression must be
non-lossy, TIFF LZW is probably the best choice.

For 8-bit (paletted and gray scale images) the best choice for
non-lossy compression is GIF LZW. If lossy compression is
acceptable, then JPEG will compress the image further.

For 1-bit  (black and white) either CALS Group 4 or TIFF
CCITT Group 4 compression for non-lossy compression.

Output Variations Compression types are one form of Output Variation.  Some of
the output formats have several variations; in those cases you can
choose among the variations in the save dialog.
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Example There are two types of Bitmap files: uncompressed and Run-
Length-Encoded (RLE).  To write out an uncompressed Bitmap
file select the None option; to write out an RLE Bitmap file
select the RLE option.

Further Variations Be aware that other options also affect the type of file that is
generated.  In particular, the number of colors in the image often
affects the type of file that is saved.  Alchemy always generates a
file using the best match of the output file format and the image.

Example Within the Windows Bitmap file type there are 1 bit, 4 bit, 8 bit,
and 24 bit files.  If the output image is black and white a 1 bit file
is generated.  If the output image is paletted with 16 colors or
less a 4 bit file is generated.  If the output image is paletted with
more than 16 colors an 8 bit file is generated.  If the output
image is true color a 24 bit file is generated.

Some image formats allow for more than one image per file.
Image Alchemy can be used to add images to those files with the
Append dialogs.

 Append

This dialog allows you to select an existing file to append to.  It
is similar to the Save As… and Save a Copy… dialogs, but does
not allow you to specify a new filename, or a format.

Append to Existing
File
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Append to New File

This dialog allows you to create a new file to append to.  If you
are saving a single image, this is equivalent to using Save a
Copy… in any of the formats that support multiple images.  If
you are saving multiple images, opened with Open Several…,
this will save all of the images to a single file.

 Export Images may also be exported to Photoshop Export plug-ins.  Any
Export plug-ins in the folder specified in the Plug-ins options
dialog will be listed under the Export menu.
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 Send to Device… This option can be used to send an image directly to various
devices.  The image can be sent through a parallel port for
NuBus Macs equipped with a Hurdler parallel board, to Axis,
JetDirect, Milan, and NetQUE interfaces from any Mac with
Open Transport installed. and to any device supported by the
Communications Toolbox.  Images may be sent to a device in
any of the following formats:

Alps
Calcomp CCRF
Encapsulated PostScript
Epson Stylus
Fargo Primera
HP PCL
HP PhotoSmart
HP RTL
Raster Graphics

If the computer is equipped with a Hurdler parallel port, it will
show up in the device list automatically.  Any other devices must
be added before they can be used.  You do this with the New
button:
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For AppleTalk and Communications Toolbox devices, use the
Choose button to select from a list of available devices.  For TCP
devices (JetDirect, Axis, and Milan in TCP mode), the Device
field should be set to the IP address or the full name of the
device.  For the Axis, this may optionally be followed by a port
name  separated by a ':'. (typically pr1).  Also for the Axis, the
port name may optionally be followed by a password, separated
by a ':'.  For any of the TCP modes, please see the bootp
documentation in the Extras folder that came with Image
Alchemy for additional information on configuring TCP devices.
The Name field is the name that will appear in the Send to
Device… dialog.

The Edit button will allow you to edit an existing device, and
Remove removes the selected device.  Use the Save button after
adding, editing, or removing a device to save your changes for
next time.

Identifying image
files

Alchemy will allow you to attempt to load a file with any
extension.  In fact, the extension is ignored by Alchemy.
Instead, Alchemy identifies the type of file being read by
checking various magic numbers and other information that
varies from format to format.  Unfortunately some formats do
not have a magic number; in those cases Alchemy attempts to
determine the image type.  It is possible for Image Alchemy to
incorrectly identify an image; if this happens please contact us.

When reading images Alchemy automatically recognizes and
reads MacBinary files (MacBinary files are generated when files
are transferred from a Mac to a non-Mac, with MacBinary mode
on).

MacBinary
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Other information Alchemy will preserve as much information in each file as is
reasonable; this always includes the height and width of the
image and the number of colors in the image.  Some file types
include other data, such as the name of the image, the aspect
ratio of the image, the date the image was created, etc.  Since
most of these items are only supported by a few file formats,
Alchemy discards everything but the height, width, number of
colors, gamma, aspect ratio, and resolution values.

Formats The individual formatssupported by Alchemy are described in
alphabetical order on the following pages.  The descriptions are
given in the template shown on the next page as “Name of
format”.
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Name of format

The save dialog showing the format selected and available output
options.

Input Options A description of the input options.  These include things like
which page for file formats that can include multiple images.  If
a file format does not have any options this section is omitted.

Output Options A description of the output options.  These usually indicate the
compression type.  If a file format does not have any options this
section is omitted.

The standard extensions for this format.  If you have Use Default
Name in the save dialog checked, most formats will add one of
the extensions listed here to the filename.  In general you will not
want to alter this extension, since many programs on other
computers rely on it when reading images.

Some formats consist of multiple files (for example, Dr. Halo
CUT images consist of a palette file and an image data file); in
those cases, Alchemy automatically generates the other
filenames from the filename given.

Extension

The company or individual who created this image format.
Please contact them for more information on the format.

Creator

Programs or types of software that use this image format.Used by

A list of the supported variations.Variations

Any known limitations that Alchemy has when reading or
writing this image format.

Limitations

Miscellaneous things you should be aware of.Comments
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ADEX

ADEX files are used by the ADEX Corporation ChromaGraph
series of graphics cards.

Output options None
Run Length Coded

Extension .img

ADEX CorporationCreator

ADEX ChromaGraph cardsUsed by

Alchemy reads and writes 4 bit and 8 bit images.Variations

Comments Some ADEX files do not contain a palette; in those cases there is
usually a second ADEX file which contains the palette to be
used.  To read those images that do not have palettes, use the
false color option on the palette panel to read the palette from a
separate file.
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Adobe Acrobat PDF

Adobe Acrobat PDF (Portable Document Format) files are used
by Adobe Acrobat.

Input Options (Image
Alchemy PS Only)

Please see the Encapsulated PostScript section for a description
of the input options.

Output Options Compression:
None
Run Length Coded
CCITT Group 3
CCITT Group 4

Binary

.pdfExtension

Adobe Systems IncorporatedCreator

Adobe AcrobatUsed by

Variations Writes 1 bit black and white, 8 bit gray scale, 8 bit paletted, and
24 bit color images.  Group 3 and Group 4 compressed images
must be black and white.
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Limitations The standard version of Image Alchemy cannot read PDF files
(Image Alchemy PS can).
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Adobe Photoshop

Adobe Photoshop files are used by Adobe Photoshop.

Output Options Compression:
None
Run Length Coded

Extension .psd

Adobe Systems IncorporatedCreator

Adobe PhotoshopUsed by

Writes 8 bit gray scale, 24 bit RGB, and 32 bit CMYK images.Variations
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Alpha Microsystems BMP

Alpha Microsystems BMP files are used by Alpha
Microsystems.

Output Options None
Packed

Extension .bmp

Alpha MicrosystemsCreator

Alpha Microsystems workstationsUsed by

Alchemy reads and writes 1, 4, 8, and 24 bit unpacked and
packed (run-length encoded) RGB images.

Variations

Limitations Reading and writing HLS images is not supported.

When reading an image without a palette Alchemy will generate
a gray-scale palette.

Comments

32          Image Alchemy



Alps

Extensions .prn

Creator Alps

Alps printersUsed by

Writes 1 bit black and white and 4 bit CMYK.Variations

Image Alchemy can only write, not read, this format.Limitations
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Autodesk Animator FLC

Input Options Page

Extensions .flc

AutodeskCreator

Autodesk AnimatorUsed by

Reads 8 bit paletted images.Variations

Image Alchemy can only read, not write, Autodesk FLC files.Limitations

When reading more than one image from a FLC file, it is most
efficient to read them in ascending order.

Comments
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Autodesk PIC

Extensions .pic

Creator Autodesk

Autodesk AnimatorUsed by

Reads and writes 8 bit paletted.Variations

This is format is only used by old versions of Autodesk software.
Newer versions use Autodesk Animator FLC instead.

Comments

Image Alchemy           35



Autologic

Autologic files are black and white or gray-scale files for use
with Autologic typesetting equipment.

Extension .gm

Creator Autologic, Incorporated

Autologic typesetting equipmentUsed by

Graphics modes 2 (black/white) and 4 (gray-scale) are supported.Variations

Only the High Speed Interface inline format is supported.

When reading, images must be preceded by a Graphics
Parameter Block.

Limitations
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AVHRR

AVHRR files are used for satellite image data.

Output Options IDIDAS Uncompressed
IDIDAS Compressed Type 1

Extension .sst

National Oceanic and Atmospheric Administration (NOAA)
National Environmental Satellite Data Information Service
(NESDIS)

Creators

IDIDAS
SSTMAP
IMGMAP

Used by

Reads 8 and 11 bits per pixel IDIDAS AVHRR files.

Writes 11 bits per pixel IDIDAS AVHRR files.

Variations

Image Alchemy           37



Limitations Level 1B AVHRR files will be supported at a later date; please
contact us for more information.

Alchemy discards all but the top 8 bits when reading 11 bit
AVHRR files.  When writing, the bottom 3 bits are padded with
0.

Any non-graphics information is discarded when reading the file.

Comments AVHRR images contain a lot of information which is not part of
the image data.  This information includes the time and date the
image was captured, the satellite which captured the image, the
type of instrumentation used, etc.  When reading AVHRR
images this information is discarded; when writing AVHRR
images 0 is written for all values for which data is unavailable.
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AVS X

Extensions .avs

Variations Reads and writes 24 bit color with an alpha channel.
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Binary Information Files (BIF)

There are quite a few programs which produce image files which
contain just pixel data.  These image files do not have a header
and hence do not include enough information to allow Alchemy
to read them.

BIF files are a method which can be used to allow Alchemy to
read these images.  BIF files can also be created to allow images
to be read by software which expects images to be just pixels.
Since required information, such as the height and width of the
image, are not present in these files you must supply it.

Type:
Interleaved
Planar
ASCII
Packed
Group 3
Group 4
Group 4 with bits reversed

Output Options
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Extensions .bif For the ASCII file describing image.
.raw For the actual image data.

Creator Handmade Software, Inc.

Used by Image Alchemy
Various image processing software

24 bit true color, 8 bit gray-scale, and 1 bit black and white.
Group 3, Group 4, and Packed BIF files are always black and
white.

Variations

Paletted files cannot be read in (a work around is to generate a
.PAL file and then false color the gray-scale image using the
False Color option).  Image Alchemy cannot read BIF files
created with the ASCII option.

Limitations

BIF files are used to read and write files which consist entirely of
image data.  You have to generate a text file which describes the
format of the data you are trying to read in.  This file is called a
BIF file.  The format of BIF files is documented in Appendix E,
Binary Information Files.  You then instruct Alchemy to read the
image data by giving it the name of the .BIF file.

Comments
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Calcomp CCRF

Calcomp raster files are used by Calcomp thermal transfer
printers, electrostatic plotters, and inkjet plotters.

Type:
Thermal Raw
Thermal (omit white space)
Thermal (rle)
Electrostatic 8
Electrostatic 16
Electrostatic 32
Inkjet 8
Inkjet 16
Inkjet 32

Landscape
Padding
Dot Expansion
Buffered

Output Options
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Extension .crf
.ccrf
.prn

Creator Calcomp

Used by Calcomp thermal printers, electrostatic plotters, and inkjet
plotters

Black and white or 1-bit CMYK.  The Landscape and Padding
options only apply to thermal transfer printers.  Landscape
causes the printer to use landscape instead of portrait orientation.
Padding may be required by certain older models; we only
recommend you try this if you find your printer does not work
without it.  Dot Expansion and Buffered apply only to
Electrostatic and Inkjet devices.  Dot Expansion causes the
plotter to run at half resolution, printing a 2x2 dot for each dot
you send it.  Buffered causes it to attempt to buffer the entire
image before starting to print.

Variations

Image Alchemy           43



CALS

Computer-aided Acquisition and Logistics Support (CALS) files
are black and white images used by the US Government as part
of their transition to electronic media.

Extension .cals

Creator Defense Logistics Agency (DLA)

Department of Defense (DoD)Used by

Alchemy reads and writes type 1 (Group 4 raster) CALS images.Variations

Document labels, such as document ID and figure ID, are
ignored.

Limitations

Comments CALS images are Fax Group IV compressed and are therefore a
good way of storing black and white line drawings and scans.
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Collage Raster

Input Options Image:
Main Image
Preview

Extensions .?

Reads and writes 8 bit grayscale, 24 bit color, and 24 bit color
with an alpha channel.

Variations

The filename extension expected by Collage software is
dependent on the rest of the filename.  Image Alchemy will
generate the appropriate extension if "Use Default Name" is on.

Comments
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Core IDC

Core IDC files are used by Core Software's GIS software.

Extension .idc

Creator Core Software Technology

Core Software TechnologyUsed by

Reads and writes 1 and 3 band files.

Reads and writes 8 bit files.

Variations

Only 8 bit images can be read.Limitations

Comments One band files are read in as gray-scale images.   Three band
files are read in as true color images.

46          Image Alchemy



Cubicomp PictureMaker

Cubicomp PictureMaker files are used in broadcast-quality three
dimensional modeling and animation.

Extensions .r8 (Red channel image data)
.g8 (Green channel image data)
.b8 (Blue channel image data)
.a8 (Alpha channel image data [optional])

Creator Cubicomp Corp.

Cubicomp PictureMakerUsed by

Alchemy reads and writes 24 bit true color images.Variations

The Alpha channel is ignored.

8-bit paletted PictureMaker files are unsupported.

Limitations
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Comments This format is not the same as IBM Picture Maker (see IBM
Picture Maker, below, for information on that format).

PictureMaker images have either three or four separate files per
image: a red, green, blue, and optional alpha channel.  You
specify the name of the .r8 file and Alchemy automatically
generates the name of the .g8 and .b8 files

When writing a PictureMaker file Alchemy will overwrite,
without warning, existing .g8 and .b8 files.
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Cum. Histogram

Extensions .hst

Creator Handmade Software, Inc.

Image AlchemyUsed by

Reads and writes 24 bit color.Variations

This format can be used to manually create a single palette for
multiple images.  To do this, append each source image to a
Cumulative Histogram file.  Then convert the resulting file into a
palette, and map the original images to the new palette.

Comments
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Dr. Halo CUT

Dr. Halo CUT files are used by various MS-DOS based paint
software.

Extension .pal (palette and header)
.cut (pixel data)

Creator Media Cybernetics

Dr. HALO III Paint Package
HALO Desktop Imager

Used by

8 bits per pixelVariations

Dr. Halo CUT images are actually two files.  You specify the
name of the .cut file and Alchemy automatically generates the
name of the .pal file.

When writing a Dr. Halo CUT file Alchemy will overwrite,
without warning, existing .pal files.

Comments
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Encapsulated PostScript (EPS)

EPS files are a subset of PostScript; they may be included by
other PostScript files without requiring that the importing
software be able to interpret the file.
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Input Options (Image
Alchemy PS Only)

(See comments below)
Page
Render Mode:

1 bit black and white
8 bit grayscale
24 bit RGB
4 bit CMYK
32 bit CMYK

Rotation:
0
90
180
270

More Options:
Output Size (Width & Height)
Page Size (Width & Height)
Offset (X & Y)
Margins (Left, Right, Top, & Bottom)
Resolution (X & Y)
Preload Fonts
Preserve Aspect Ratio
Clip
Antialias

Output Options Preview:
None
Device independent Preview
TIFF Preview

NewLines:
Mac
Unix
MSDOS

Showpage
Binary

Extensions .eps
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Creator Adobe Systems, Inc.

Used by PostScript printers

Variations Image Alchemy can write black and white, gray-scale, RGB,
CMYK, and indexed images.  The Preview option controls
whether a preview is included in the file, and if so what type.
The Showpage option causes Alchemy to include a showpage
command in the file, allowing it to be printed directly.  The
Newline option controls what style newline is used in the file.

The standard version of Image Alchemy cannot read EPS files
(Image Alchemy PS can).

Limitations

See the section on the Options dialogs for information on font
handling.  See the Comments field in the Get Info… or Get Info
for filename… dialogs for a list of any fonts that were not found.

Input Comments
(Image Alchemy PS
Only)

Page controls which page of the file to render.  If you will be
reading more than one page from a PostScript file, it is most
efficient to read the pages in order.

Page

The mode controls whether the file is to be rendered in black and
white, 8 bit grayscale, 24 bit rgb, 4 bit cmyk, or 32 bit cmyk.  24
bit rgb and 32 bit cmyk will fall back to 8 bit grayscale is there is
no color in the file.  All of the modes will fall back to 1 bit black
and white if there is no color or intermediate grays in the file.
However the grayscale and color modes require more memory
and processing time than black and white, even if they end up
falling back to black and white.  If the input file contains an
Adobe ImageData comment, the initial render mode will be set
to match the original image.

Render Mode

Rotation can be used to rotate the image to any of four
orientations.  The image is rotated the specified number of
degrees clockwise.

Rotation
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More Options There are many additional options on the More Options…
dialog:

The units used by the numeric fields above are controlled by the
Units setting in the Files:Options:General Options… dialog.  The
size units can be overridden by following the number with a 'p'
for pixels, 'i' for inches, 'c' for centimeters, or 'm' for millimeters.
The resolution units may be overridden by following the number
with a 'i' for dots per inch, 'c' for dots per centimeter, or 'm' for
dots per millimeter.

Page Size & Offset Output Size determines how large  the rendered image will be.  If
it is left empty, it will default to the same as the input size.

Input Size is the page size as far as the PostScript or PDF file is
concerned.  It defaults to 8.5"x11", but the file can override the
default.

The X and Y Offsets shift the page relative to the image to the
right and down (for positive numbers).  Alchemy will
automatically fill in the offsets and input page size when you
select a file that contains a bounding box in the header; you may
override those values.  Note that the input size and offsets are
before any rotation (from the rotation option, above) is
performed, and the output size is after.
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Resolution The Resolution fields control the resolution the file will be
rendered at.  If the input file includes an Adobe ImageData
comment the resolution fields will be filled in to match the
original image resolution.  If left empty, the resolution will
default to 72DPI.  It is possible, although very rare, for a
PostScript file to override the default resolution.  However, it can
not override a resolution you explicitly set.

The default resolution of 72DPI is a good choice for rendering
images to be used on the screen.  If you are going to be sending
them to a printer, you will probably want something higher, such
as 300DPI.

The specified resolution will be the effective resolution at the
output size.  If you specify an output width of 2 inches and a
resolution of 100dpi, you will end up with a 200 pixel wide
image.  If you specify an output width in pixels, then the image
will be that many pixels across regardless of the resolution.

Margins The margins allow you to specify an area of the page that will
not be drawn in, and will not be included in the output image.
This can be useful if you are converting images to be sent to a
device that has inherent margins; you can set the margins here to
be equal to the device's margins so that the PostScript or PDF
data will be the intended distance from the paper edge.

Preload Fonts This causes Alchemy to preload all of the fonts mentioned in the
Fontmap.  Normally Alchemy only loads fonts as needed;
loading all of them can take quite a bit of time and memory.
This is usually only useful for some very special purpose
PostScript files, such as font catalogs.

This will cause the image to fit within a box you specified as the
output page size, without distorting the image.  For example, if
the input page size is 8.5"x11", and you specify an output page
size of 640x480 pixels with preserve aspect turned on, the
resulting image will be 371x480 pixels.

Preserve Aspect
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Clip This will cause any white space to be trimmed from the edges of
the image.  This occurs after any scaling caused by the page size
and resolution controls, so you will not necessarily end up with
an image that is the same size as you specified in the output size
fields.

Anti-Alias Anti-Alias causes Alchemy to anti-alias the image.  This is
particularly useful when producing relatively low resolution
output for use on a display; it will prevent the jaggy appearance
of low resolution characters and other curves.  A setting of
medium is usually fine for use at typical display resolutions.
Higher settings require more memory and processing time.

Output Comments If the output is gray-scale, it will work with any PostScript
device.  If it is true color, then the CMYK extensions or a level 2
device is required.  For paletted files, a level 2 device is always
required.

TIFF previews are more widely supported than device
independent.  The Showpage option should be harmless for
images that will be imported into another application, as they are
required to strip it out.  However some applications fail to do so,
so Alchemy provides the option whether to include it.
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Epson Stylus

Epson Stylus files are used by Epson Stylus printers.

Output Options Microweave
Bidirectional

Extension .prn

EpsonCreator

Epson Stylus printersUsed by

1 bit CMYKVariations

Limitations Epson Stylus files can only be 720, 360, or 180 DPI.  If you
specify any other DPI value the output file will automatically
switch to one of those.
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ER Mapper Raster

ER Mapper files are used by ER Mapper satellite image analysis
software.

Extension .ers Header data
. Pixel data

Creator Earth Resource Mapping

ER MapperUsed by

Reads and writes single channel and 3 channel images.Variations

ER Mapper files are actually two files, one with the extension
.ers and the other without any extension.  The .ers file contains
header information and the non-extensioned file contains the
actual image data.  You specify the name of the .ers file and
Alchemy automatically generates the name of the other file.

Comments

When writing an ER Mapper file Alchemy will overwrite,
without warning, existing ER Mapper image data files.

One band files are read in as gray-scale images.
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Three band files are read in as true color images.  The default
color mapping between RGB and bands 1, 2, and 3 is Red=Band
1, Green=Band 2, and Blue=Band 3.
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Erdas LAN/GIS

Erdas files are used by Erdas image processing software.

Extensions .lan

Creator Erdas Inc.

Erdas remote sensing softwareUsed by

Alchemy reads and writes 1 and 3 band files.

Alchemy reads 4, 8, and 16 bit files and writes 8 bit files.

Variations

When writing Erdas files Alchemy does not change the extension
depending on the number of bands in the image; according to the
specification gray-scale files should have the extension .gis and
true color files should have the extension .lan.  Alchemy always
uses .lan.

Limitations

Comments One band files are read in as gray-scale images.
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Three band files are read in as true color images.  The default
color mapping between RGB and bands 1, 2, and 3 is Red=Band
1, Green=Band 2, and Blue=Band 3.
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Fargo Primera

Fargo Primera files are used by Fargo Primera printers.

Output Options Type:
Thermal 3 color
Thermal 4 color
Thermal BW
Dye Sub
Dye Sub BW

300DPI

Extension .prn

FargoCreator

Fargo Primera printersUsed by

Black and white, 1 bit CMYK.Variations
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FaxModem

Extensions .fax

Creator Hayes

Hayes JTUsed by

Reads and writes 1 bit black and white.Variations
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FBM

Fuzzy Pixmap Manipulation

Extensions .fbm

Creator Michael L. Mauldin

Fuzzy Pixmap image manipulation packageUsed by

Reads and writes 8 bit paletted and 24 bit color.Variations
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First Publisher ART

First Publisher ART files are black and white images used as clip
art by First Publisher.

Extension .art

Creator Software Publishing Corp.

First PublisherUsed by

Black and white, 1 bit per pixel.Variations
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Freedom of Press

Freedom of Press is a PostScript interpreter from Custom
Applications that converts PostScript files to raster files.  The
Freedom of Press format is one of the file types it can create.

Extension .fop

Creator Custom Applications

Only 1 bit black and white and 4 bit CMYK are supported.Limitations

Freedom of Press images are actually two files, a data file and an
info file.  You specify the name of the data file and Alchemy
automatically generates the name of the info file.  The output file
is normally output.001, output.002, etc.  Alchemy will strip the
first part of the name and replace it with 'info', so if you specified
an output filename of output.005 there will be another file
created called info.005.  If you do not specify an extension,
Alchemy will use .fop, so you will get two files named
filename.fop and info.fop.  Alchemy will overwrite info files
without warning.

Comments
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GEM VDI Image File

VDI files are files that were developed by Digital Research to
use with GEM.

Extension .img

Creator Digital Research Inc.

GEMUsed by

Alchemy reads 1-8 bit grayscale and 3 and 4 bit color files.

Alchemy writes 1, 3, and 4 bit grayscale and 3 and 4 bit color
files.

Variations

The support for color and multiple bit grayscale GEM files is not
very universal.  Therefore make sure the application you are
using to read the GEM files can in fact handle them.

Limitations
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Alchemy defaults to writing out a 1 bit, black and white GEM
file.  You can explicitly force a 3 plane color file by specifying 8
colors and a 4 plane color file by specifying 16 colors (you may
also specify black and white  to write a grayscale file instead of a
color file).

Comments Because color GEM files have only 3 or 4 bits of information
and no palette support the quality is generally not very good for
scanned images.  The GEM format seems to have been designed
for line drawings.
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GIF

GIF files were originally developed by CompuServe as a
machine independent image file format.  GIF files are clearly the
most popular way of storing 8 bit, scanned or digitized images.
In addition the compression ratio achieved by GIF files is usually
better than any other 8 bit format in common use.  GIF89A files
were introduced in 1990 as a method for including text and
simple animation.

Input Options Page

Output Options Version:
GIF87A
GIF89A

Interleave

.gifExtension

CompuServe, IncorporatedCreator

CompuServe
Everyone

Used by
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Variations Alchemy reads 1 through 8 bit GIF87A and GIF89A interleaved
and non-interleaved files.

Alchemy writes 1 through 8 bit GIF87A and GIF89A interleaved
and non-interleaved files.

Limitations When reading GIF89A files any text, overlays, pauses, palette
changes, etc. are ignored.

Because GIF files only store the size of the palette to the nearest
power of 2 the exact palette size is lost when converting to and
from GIF files.  For example, if you convert a 240 color Sun
Raster file to a GIF file and back to a Sun Raster file the
resulting Sun Raster file will have 256 colors.

The GIF format includes a field for storing the color to be used
for the background when viewing files.  Alchemy does not make
use of this value.

Comments

70          Image Alchemy



GOES

GOES files are used for satellite image data.

Output Options GARS format
McIDAS format

Extension .goes

The University of Wisconsin
National Oceanic and Atmospheric Administration (NOAA)
National Environmental Satellite Data Information Service
(NESDIS)

Creators

Various satellite image processing software, including the
McIDAS system

Used by

Alchemy reads 8, 16, and 32 bits per pixel GOES images.

Alchemy writes 8 bits per pixel images.

Variations

Limitations When reading 16 and 32 bit images Alchemy discards all but the
top 8 bits of data.
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Alchemy discards any calibration data and level maps when
reading images.

Because of difficulty in getting a sufficient number of test
images in the GOES format (especially the PUT format) reading
GOES images has not been thoroughly tested.  If you have any
GOES images which Alchemy does not read correctly please
contact us.

Comments The GARS format is a 7680 bytes per block, Motorola byte-
order, EBCDIC format; the MCIDAS format is a continuous
data, Intel byte-order, ASCII format.

GOES images contain a lot of information which is not part of
the image data.  This information includes the time and date the
image was captured, the satellite which captured the image, the
type of instrumentation used, etc.  When reading a GOES image
this information is discarded; when writing a GOES image 0 is
written for all values for which data is unavailable.
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Hitachi Raster Format (HRF)

Hitachi Raster Format (HRF) files are black and white images
used by CADCore.

Input Options Page

Extension .hrf

Hitachi Software Engineering Co., Ltd.Creator

Information and Graphics Systems, Inc. (IGS)Used by

Black and white, 1 bit per pixel.Variations
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HP Printer Command Language (PCL)

HP PCL files are used by HP LaserJets and compatible printers.

Input Options Page

Output Options Compression:
None
RLE
TIFF
Delta

Landscape
PCL5
Exp Margins

.pclExtension

Hewlett-Packard CompanyCreator

HP LaserJet printers
HP compatible laser printers

Used by

Variations PCL files are always 1 bit per pixel, black and white.
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Alchemy reads and writes uncompressed, RLE, TIFF, and Delta
compressed files.

Limitations In addition to raster images, PCL files can include text and
vector graphics information.  When reading Alchemy only pays
attention to raster images in the file and attempts to skip
everything else.

The only resolutions allowed in non-PCL5 files are 75 DPI,
100 DPI, 150 DPI, and 300 DPI.  PCL5 adds 200 DPI and 600
DPI.  The X and Y resolution must be the same.  If you specify
any other resolution Alchemy automatically alters the resolution
to the next higher resolution.  If no resolution is specified
Alchemy automatically selects a resolution which will allow the
entire image to fit on the page.

LaserJet II, IID, and earlier printers can print only uncompressed
PCL files.  LaserJet IIp printers can print only uncompressed and
RLE compressed files.  LaserJet III, IIID, IIIp, IIIsi, and 4
printers can print all types of compressed PCL files.

The Landscape option can be used to write a landscape PCL file.
Because of changes in the PCL format, only LaserJet III and
newer printers can print Alchemy produced landscape PCL files.

The Exp. Margins option causes the printer to print as close to
the edges of the page as possible.

When converting color or gray-scale images to PCL you will
probably want to scale the output so the image will be larger than
the input image.  This will allow the dithering to preserve more
detail in the image.

Comments
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HP PhotoSmart

HP PhotoSmart format is used by the HP PhotoSmart printer.

Extensions .prn

Creator Hewlett-Packard Company

HP PhotoSmart printerUsed by

Writes 24 bit color files.Variations

Image Alchemy can only write, not read, PhotoSmart files.Limitations
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HP Raster Transfer Language (RTL)

HP RTL files are used by HP color raster printers and plotters.

Devices:
PaintJet
HP7600
DesignJet 3 bit
DesignJet 4 bit
DesignJet 24 bit
DesignJet 24 bit alternate dither
NovaJet

Types:
Non-Planar
Planar

Compression:
Uncompressed
Packbits compressed
Group III compressed.

On the Fly

Output Options
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Extension .rtl

Creator Hewlett-Packard Company

Used by HP raster plotters and printers including PaintJets, HP 7600
Series plotters, and DesignJets

NovaJet Plotters.

Writes 1 bit black and white, 4 bit CMYK, and 24 bit RGB.Variations

Output only.Limitations

RTL files can be used to produce output which can be printed on
HP color printers and raster plotters.  The file can be printed by
sending the file to the plotter.  There is no additional setup
required for the PaintJet.  HP7600 series plotters should be in
HP-GL/2 mode; best results will generally be achieved with
compensation off.  To get color plots from the HP7600 series the
plotter must be in 4 or 5 pass mode.

Comments

On the fly mode can be used by DesignJet users to tell the plotter
to start plotting before it has received the entire image.  This can
be useful if you are plotting very large images and running out of
plotter memory.

All devices can output uncompressed files.  PaintJet 300s,
DesignJets, NovaJets, and HP7600s can handle PackBits
compression.  DesignJets and HP7600s can handle Group III
compression.

Planar mode only has an effect on HP7600 output.  It allows the
plotter to start plotting each plane after it is received, rather than
having to store the entire image.  This can be useful if you are
running out of plotter memory.
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HP-48sx Graphic Object (GROB)

Graphic Object files are used by HP-48sx calculators.

Input Options Mode:
1 bit
2 bit

Output Options Type:
Binary
ASCII

.grb

.asc
Extension

Hewlett-Packard CompanyCreator

HP-48sx calculatorsUsed by

Variations Black and white, 1 bit per pixel.
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HSI Palette

HSI Palette files are palettes which are ASCII files that can be
edited with a text editor.

Extension .pal

Creator Handmade Software, Inc.

Image AlchemyUsed by

Palette files are always ASCII files.Variations

.PAL files contain only a palette.Limitations

Comments The format of PAL files is described in Appendix H.
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HSI Raw

HSI Raw files are used internally by Image Alchemy when
converting between certain combinations of image formats.  If
you are interested in converting custom format images to be used
with Image Alchemy we suggest using HSI Raw Files.

Extension .raw

Creator Handmade Software, Inc..

Image AlchemyUsed by

8 bit paletted and 24 bit true color, uncompressed, not packed.Variations

This is not the format for importing data which has no header
information, see Binary Information Files (BIF) above for
information on doing that.

This format is used internally as temporary files by Alchemy
when doing certain image conversions; it can also be explicitly
read and written.  This format is described in Appendix F.

Comments
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IBM Picture Maker

IBM Picture Maker files are used by IBM presentation software.

Extension .pic

Creator IBM

IBM Storyboard Live!Used by

Alchemy reads and writes 256 color Picture Maker files.Variations

16 color Picture Maker files are not supported.  Picture Maker
images cannot be larger than 640x480.

Limitations

Comments This is not the same format as Cubicomp PictureMaker (see
above for information on the Cubicomp PictureMaker format).

256 color Picture Maker files may be either 320x200 or
640x480.  Image Alchemy will write the smallest variation that
the image will fit in, with the image centered; the borders will be
filled with color 0.
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IDRISI

Output Options Type:
Binary
Packed Binary
ASCII

Extensions .doc

Reads and writes 8 bit grayscale.Variations
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IFF/ILBM

IFF (Interchange File Format) files are used by Amiga computers
for storing a number of types of data, including images, text, and
sounds; ILBM (InterLeaved BitMap) is a type of IFF file used to
store images.

Extensions .lbm

Creator Commodore-Amiga Corp..

Amiga
Deluxe Paint

Used by

Alchemy reads 1 through 8 bit, 24 bit, and HAM images

Alchemy writes 1 through 8 bit and 24 bit images.

Variations

Dynamic Hi-Res images are not supported.

Does not write images in any of the Amiga specific display
modes.

Limitations
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Comments If you are writing an ILBM file for use on an Amiga, you
probably want to write either a paletted file with 32 colors or a
24 bit file.  24 bit ILBM files can then be converted to one of the
Amiga specific display modes with various third-party utilities.
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Imaging Technology

Extensions .img

Creator Imaging Technology

Imaging TechnologyUsed by

Reads and writes 8 bit grayscale.Variations
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Img Software Set

The Img Software Set  is a collection of tools for manipulating
graphic images freely available for various UNIX workstations.

Extensions .img
.p
.a

Creator Paul Raveling

Img Software SetUsed by

Reads and writes 8 bit paletted and 24 bit images.Variations

Alchemy does not read nor write compressed (.Z) images.  Use
the UNIX supplied uncompress program to decompress those
images before reading with Alchemy.

Limitations

Comments The Img Software Set is available via anonymous ftp as
expo.lcs.mit.edu:contrib/img_1.3.tar.Z or
venera.isi.edu:pub/img_1.3.tar.Z or on floppy disk from us.
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Intergraph

The Intergraph file format was developed by Intergraph Corp.
and is used by them..

Output Options Format:
Type 9
Type 24
Type 27

Extensions .prn

Intergraph Corp.Creator

Intergraph Corp.Used by

Reads and writes types 9 and 24 1 bit black and white and type
27 24 bit color images.

Variations

Limitations If  you need to read or write other types of Intergraph files please
contact us; we are happy to add support for any of the Intergraph
formats.
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Iris

Extensions .ct

Used by Iris printers

Reads and writes 32 bit CMYK.Variations
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JEDMICS C4

Joint Engineering Data Management Information and Control
System

Input Options Image:
Main Image
Preview

Output Options Format:
1991-04-10
1997-05-09

Preview

.c4Extensions

US Department of DefenseCreator

US Department of Defense and contractorsUsed by

Variations Reads and writes 1 bit black and white.
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Jovian VI

Jovian VI files are created by the Jovian Logic video capture
boards.

Extension .vi

Creator Jovian Logic Corp.

Jovian LogicUsed by

Alchemy reads 1, 4, 6, and 8 bit gray-scale images, 4 and 8 bit
color paletted images, and 16 and 24 bit true color images.

Alchemy writes 8 bit gray-scale, 4 and 8 bit color paletted
images, and 16 and 24 bit true color images.

Variations

Alchemy reads files with 6 and 8 bit palettes;  Alchemy always
writes 6 bit palettes.

Gray-scale files are always 8 bit.

Limitations
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Comments When writing a VI file the palette always starts at 0, but will not
necessarily be black (which is the way that Jovian VI files are
written).

92          Image Alchemy



JPEG/JFIF

JPEG is a lossy compression technique to achieve high
compression ratios.  See Appendix C, JPEG Compression, for
more information.

Output Options Quality

Coding:
default Huffman coding
optimum Huffman coding

Passes:
1-10

Profile

Extension .jpg

Joint Photographic Experts Group (JPEG)Creator

EveryoneUsed by

Gray-scale images are saved as single channel JPEG files; color
images are saved as three channel JPEG files.

Variations
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Alchemy writes baseline JPEG with CCIR-601 YCbCr color
space, interleaved components, Huffman coded, and 2h:1v 1h:1v
1h:1v subsampling.

Alchemy JPEG files comply with the industry standard 'JFIF'
interchange format.

Limitations JPEG files are always lossy, which means that the compressed
image is not identical to the original image.  At high quality
factors (32 and above) this loss is generally so slight as to be
barely noticeable.  There is no quality factor which is guaranteed
to be lossless.

Comments By default, Alchemy uses a fixed set of Huffman tables to
compress an image.  If the optimum Huffman table option is
chosen, Alchemy will generate a set of custom tables optimized
for the image and quality factor.  This usually produces 5-20%
better compression (depending on the image content and quality
factor) but requires an additional pass over the image data, so it
takes a little longer to compress (there is no effect on the
decompression time).

Quality may vary between 1 and 100; the default is 32.  The
higher the number the higher the quality of the image and the
lower the compression ratio.  Quality factors below 10 will
produce images with significant loss of quality.

If Passes is 1, Alchemy will generate a sequential JPEG file;
otherwise it will generate a progressive JPEG file.

JPEG files are based on the Joint Photographic Experts Group
(JPEG) CD 10918-1 standard.
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Since JPEG compression was designed for use with continuous
tone images (such as those produced by a scanner or digitizer),
poor results can be expected when compressing line drawings.

If there is an ICC profile available (see the section on the
Profile… dialog), it may be included in the JPEG file by
selecting the Profile box.  Alchemy will automatically read a
profile, if present, from a  JPEG file.
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Kodak PhotoCD

PhotoCD files are multi-resolution images produced by Kodak.

Input Options Resolution:
192x128
384x256
768x512
1536x1024
3072x2048

Mode:
Color
Gray

Extensions .pcd

Eastman Kodak CompanyCreator

Eastman Kodak CompanyUsed by

Reads 8 bit grayscale and 24 bit color images, in resolutions up
to 3072x2048.

Variations

Limitations Image Alchemy can only read, not write, this format.
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Lumena CEL

Lumena CEL files are used by Time Arts software.

Extension .cel

Creator Time Arts

LumenaUsed by

Reads and writes 15 and 32 bit images, ignoring the alpha
channel when reading 32 bit images and writing an empty
channel when writing 32 bit images.

Variations
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Macintosh PICT/PICT2

PICT files were created by Apple Computer as a common format
for Macintosh applications to use.  Virtually every Macintosh
application can use PICT files.

Extensions .pict

Creator Apple Computer, Inc.

Macintosh computersUsed by

Alchemy writes 1, 2, 4, 8, and 32 bit PICT2 images.Variations
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MacPaint

MacPaint files were created by Apple Computer as the format
that MacPaint used.  MacPaint files have generally been usurped
by Macintosh PICT files, but are still supported by some
software.

Extensions .mac

Creator Apple Computer, Inc.

MacPaintUsed by

MacPaint images are always 1 bit, black and white, 576x720
pixels.

Variations

MacPaint images are always 576x720.  If you attempt to write an
image which is larger Alchemy will report this as an error.  If
you write an image which is smaller Alchemy will pad the image
with white space along the right-hand side and bottom.

Limitations
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MIFF

MIFF.

Input Options Page

Output Options Compression:
None
RLE

.miffExtensions

John CristyCreator

Image MagickUsed by

Variations Reads and writes 8 bit grayscale, 8 bit paletted, 24 bit color, and
24 bit color with an alpha channel.
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MTV Ray Tracer

MTV files are used by the MTV RayTracer, a public domain ray
tracer for Suns and other workstations.

Extension .mtv

Creator Mark T. VandeWettering

MTV RaytracerUsed by

24 bit true color.Variations

MTV is a public domain ray-tracer available free of charge via
anonymous ftp from drizzle.cs.uoregon.edu or via floppy disk
from us.

Comments
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OS/2 Bitmap (BMP)

OS/2 BMP files are used by OS/2 2.x and OS/2 Warp.

Output Options None
RLE

Extension .bmp

IBM Corp.Creator

OS/2 2.x
OS/2 Warp

Used by

Alchemy reads 1, 4, 8, and 24 bit RGB (raw), RLE4, and RLE8
files.

Alchemy writes 1, 4, 8, and 24 bit RGB (raw), RLE4, and RLE8
files.

Variations
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OS/2 Icon

OS/2 Icon files are used by OS/2 2.x and OS/2 Warp.

Extension .ico

Creator IBM Corp.

OS/2 2.x
OS/2 Warp

Used by

Alchemy reads and writes 1, 4, 8, and 24 bit RGB files.Variations
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PCPAINT/Pictor Page Format

The Pictor format was designed so that an image could be loaded
into an IBM graphics adapter very quickly; it does this by almost
exactly duplicating the organization of the graphics adapter
memory.  This makes the format hardware dependent.

640x200x16 EGA
640x350x2 EGA
640x350x4 EGA
640x350x16 EGA
640x350x16 VGA
320x200x16 EGA
320x200x256 VGA/MCGA
640x480x16 VGA
640x480x2 VGA/MCGA
800x600x2 EGA/VGA
800x600x16 EGA/VGA
640x400x256 SVGA

Output Options

104          Image Alchemy



640x480x256 SVGA
800x600x256 SVGA
1024x768x2 SVGA
1024x768x16 SVGA
360x480x256 VGA
1024x768x256 SVGA

Extension .pic

Creator John Bridges

PCPAINT
GRASP

Used by

There are variations for most IBM and third party graphics
adapter display modes.

Variations

Only the EGA and VGA modes are supported at this time.  Text
modes are not supported.

Limitations

Some Pictor files do not contain palettes.  For those files
Alchemy will default to using a standard palette appropriate to
the display mode the file was saved in.  However, the image may
not use the default palette; in that case you can read the palette
from another file with the false color command.

Comments
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PCX

PCX files are used extensively by MS-DOS machines.
Originally created by ZSoft for use by their paint packages, PCX
files can be read and written by almost all MS-DOS paint
software and desktop publishing software.

PCX files suffer from two problems:  the compression ratio is
poor for 8 and 24 bit images and PCX files are often written out
incorrectly; see the Limitations section below for details.

Standard PCX
PCJ

Output Options

Extensions .pcx for PCX files

.pcj

.p13 for PCJ files

ZSoft CorporationCreator
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Used by PC Paint
Publisher's Paintbrush
Most paint and desktop publishing software can read and write
PCX files.

Variations 1, 4, 8, and 24 bits per pixel for standard PCX files.

Limitations PCX format files are often written out incorrectly; Alchemy
attempts to figure out what is wrong and make intelligent
decisions (things Alchemy can deal with include PCX files
without palettes, files missing the last line of image data, and
files with illegal (and incorrect) combinations of bits per pixel
and planes).

Because so many software packages can read and write PCX
files we are especially interested in supporting as many
variations as possible.  If you have any PCX files which
Alchemy does not read correctly please contact us.

ZSoft recently changed some of the information in the header of
PCX files so they now include image resolution.  Some fax
board software makes use of this information when transmitting
PCX files as faxes.

Comments
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PCX (DCX)

DCX is a variation on the PCX file format used by some fax
software.

Input Options Page

Extension .dcx

ZSoft Corporation created the original PCX specification on
which DCX is based.

Creator

Fax board softwareUsed by

1 bit per pixel.Variations
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PDS

PDS labeled images are used by NASA for planetary images.

Extensions .ibg
.imq

Creator NASA

NASA distributes collections of planetary images on CD-ROM
in PDS format.

Used by

Alchemy reads 1 and 8 bit uncompressed and 8 bit first
difference Huffman compressed files.

Alchemy writes 8 bit gray-scale uncompressed PDS files.

Variations

PDS images must begin with either an "SFDU_LABEL" or a
"FILE_TYPE" record for Alchemy to be able to identify it.

Limitations
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Occasionally a PDS labeled image has a palette.  There does not
seem to be any standard format for the palette; Image Alchemy
handles the palettes we have encountered.

Any portions of the PDS labels not required to extract the image,
such as longitude and latitude, are ignored.

Comments Some PDS images actually consist of two files, a label file and a
data file.  To read that type image you should use the name of the
label file and Alchemy will find the data file.
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Pixar

Extensions .pic

Used by Pixar

Reads 8 bit grayscale, 24 bit color, and 24 bit color with an alpha
channel.

Variations

Image Alchemy can only read, not write, Pixar images.Limitations
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Portable BitMap (PBM)

The Portable BitMap format was developed by Jef Poskanzer to
allow the transferring of black and white image files between
different workstations.  The PBM format has grown to include
black and white, gray-scale, and true color images, a large set of
programs to convert various other image formats to and from
PBM, and a set of image manipulation tools.  The PBM tools are
available free of charge from numerous ftp sites (see below for
details).

.pnm Portable aNyMap (Any of those below)

.pbm Portable BitMap (Black and white)

.pgm Portable GrayMap (Gray-scale)

.ppm Portable PixelMap (True color)

Extensions

Creator Jef Poskanzer

Portable BitMap Package
Various workstation graphic programs

Used by
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Variations Alchemy reads and writes 1, 8, and 24 bit RAWBITS (binary)
images.

To write out a PBM file select black and white and two colors
To write out a PGM file select black and white and 256 colors.
To write out a PPM file select true color (24 bit).

Limitations When writing a PBM file Alchemy always uses the .pnm
extension (the extension should be changed based on the type of
file being written).

Comments The PBM package is a set of image manipulation tools which run
on various workstations.  The software is available for free via
anonymous ftp from expo.lcs.mit.edu as contrib/pbmplus.tar.Z,
ftp.ee.lbl.gov as pbmplus.tar.Z, or via floppy disk from us.
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Portable Network Graphics (PNG)

PNG files are used by the WWW.

Output Options Filter:
None
Sub-filtering
Up-filtering
Averaging
Paeth filtering
Adaptive filtering

Interleaved

Extensions .png

The PNG development groupCreator

WWWUsed by

Reads and writes 1 bit black and white, 2, 4, and 8 bit grayscale,
2, 4, and 8 bit paletted, and 24 bit color images, with and without
alpha channels, and with and without transparency information.

Variations
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Limitations Non-image chunks (such as copyright information) are discarded
when reading.

Comments
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Puzzle

Puzzle files are used by the X supplied Puzzle program.

Extension .puzzle

Creator Don Bennett, HP Labs

puzzle as distributed with the X Windowing SystemUsed by

Puzzle files are always 8 bits per pixel.Variations
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Q0

The Q0 format is apparently commonly used by various Japanese
scanning, painting, and viewing software to store 24 bit images.
Handmade Software has no information other than a basic
description of the format and some sample images; if you have
further information on the Q0 format please contact us.

Extensions .q0 For pixel data
.rgb For pixel data
.fal For image header information

Creator Unknown

Various Japanese image processing softwareUsed by

24 bits per pixelVariations
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Comments Q0 files are actually two files, one with the extension .rgb or .q0
and the other with the extension .fal.  The .rgb or .q0 file
contains the actual image data and the .fal file contains the
header information (primarily the height and width of the
image).  You specify the name of the .rgb or .q0 file and
Alchemy automatically generates the name of the .fal file.

When writing a Q0 file Alchemy will overwrite, without
warning, existing .fal files.
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QDV

The QDV format is used by Giffer, a Macintosh program which
displays and converts image files.

Extension .qdv

Creator Steve Blackstock

GifferUsed by

QDV files are always 8 bits per pixel.Variations
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QRT Raw

QRT files are generated by the QRT Ray Tracer, a public
domain ray-tracer for Amiga, Macintosh, and IBM PC
computers.

Extension .raw

Creator Steve Korn

QRT Ray TracerUsed by

24 bits per pixelVariations
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Raster Graphics

Extensions .rg

Used by Raster Graphics plotters

Writes 1 bit black and white, 4 bit CMYK, 24 bit RGB, and 32
bit CMYK images.

Variations

Image Alchemy can only write, not read, Raster Graphics
images.

Limitations
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RIX

RIX files are color files developed by ColoRIX to use with their
paint software.

Extension .scx

Creator RIX Softworks, Inc.

ColoRIX softwareUsed by

Alchemy reads and writes Type 0 (8 bits per pixel) and Type 4 (4
bits per pixel) images.

Variations

We would like to add support for Type 1 and Type 2 images but
we have not been able to find any; if you have some please
contact us.

Limitations

Comments A type 0 file will be written if there are more than 16 colors in
the image; otherwise a type 4 file will be written.
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RLC Image

Extensions .rlc

Variations Reads and writes 1 bit black and white images.
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Scitex

Extensions .ct

Used by Scitex scanners

Reads and writes 8 bit grayscale, 24 bit RGB, and 32 bit CMYK.Variations
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Scodl

Scodl files are used by Agfa/Matrix slide recorders.

Output Types Pre 4.2
Post 4.2 (See the Comments section, below)

Extension .scd

Agfa Corporation / Matrix Instruments Inc.Creator

Agfa/Matrix slide recordersUsed by

Alchemy writes 8 and 24 bit run-length coded (RLC) images.Variations

Limitations Output only.
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Comments Agfa/Matrix made significant changes to the Scodl file format
when they introduced version 4.2 of the MVP and Conductor
software in 1992.  Old version Scodl files could not be scaled by
the MVP software; new version Scodl files can be scaled but
only work the newer version of the MVP and Conductor
software.

Scalable Scodl images have the advantages that they do not have
to be scaled to a specific output resolution and are therefore
generally smaller than pre-scaled Scodl images.  They can also
be imaged on a film recorder with any output resolution or
previewed on a monitor.

The disadvantage of scalable Scodl images is that you must be
using at least Scodl MVP version 4.2 and the Scodl MVP
software does not perform very high-quality scaling.  In
particular, the MVP software only does pixel replication scaling
when increasing the size of an image and pixel averaging when
reducing the size of an image.

Note that Alchemy pays attention to the aspect ratio or dots per
inch information when converting to a Scodl scalable image.
Therefore you should ensure that this information is correct
when writing a Scodl scalable image.

When writing Non-scalable Scodl files the image should be
scaled up to either 2000x1366 or 4000x2732 to fill the slide.
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There are some limitations with the MVP software driver
supplied by Agfa/Matrix:

24 bit Scodl files are not correctly interpreted by the MVP
driver version 4.1 and earlier.  8 bit images are correctly
interpreted.

When sending very large images to the background MVP
driver you must be using version 4.0 or later and have lots
of EMS memory (4 megabytes is recommended).  When
using the foreground MVP program turning on disk
caching is necessary.
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Silicon Graphics Image (SGI)

Silicon Graphics Image files are used by Silicon Graphics
workstations.

Output Options Compression:
Verbatim (uncompressed)
RLE compressed

New Style

Extension .sgi

Silicon Graphics, Inc.Creator

Silicon Graphics workstationsUsed by

Alchemy reads and writes 1, 8 (gray-scale), and 24 bit verbatim
(uncompressed) and RLE files.

Variations

Comments Only gray-scale images may be 8 bit files.  Alchemy will
automatically switch to 24 bit mode when writing a color image.
New Style changes to a slightly different version of the SGI
Image specification.
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Sharp GPB

Sharp GPB files were developed by Sharp.

Extensions .img

Creator Sharp

SharpUsed by

Reads and writes 1 bit black and white, 8 bit grayscale, and 24
bit color images.

Variations
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Spaceward Graphics

Spaceward Graphics files were developed and are used by
Spaceward Graphics.

Output Options Type:
None
Run length coded

Extensions .r Red channel image data
.g Green channel image data
.b Blue channel image data

Spaceward GraphicsCreator

Spaceward GraphicsUsed by

Reads and writes 1 bit black and white, 8 bit grayscale, and 24
bit color images.

Variations
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SPOT Image

SPOT Image GIS data files are high-resolution satellite images
produced by SPOT Image Corporation.

Extensions .hdr (For image header information)
.bil (For pixel data)
.clr (For palette data [optional])

Creator SPOT Image Corp.

SPOT Image Corp.Used by

8 bits per pixelVariations

Only 1 band, GIS images are supported; if you have any other
type of SPOT GIS images we would be interested in supporting
them; please contact us.

Limitations
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Comments SPOT Image images are actually three files.  You specify the
name of the .hdr file and Alchemy automatically generates the
name of the .bil and .clr files.

If no palette file (.clr file) exists Alchemy will assume the image
is grayscale.

There may also be a statistics file, with a .stx extension, but
Alchemy ignores this file.

When writing a SPOT file Alchemy will overwrite, without
warning, existing .bil and .clr files.
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Stork

Stork files are CMYK images used by Stork's color proofing
machines.

Output Options None
Run length coded

Extensions .idx Index file
.pre Image data
.tab Color lookup table

Stork Colorproofing B.V.Creator

Stork Colorproofing machinesUsed by

Alchemy reads and writes 32 KCMY, 32 KCMY RLC, 16 CLU,
and 16 CLU RLC images (type 100, 101, 300, and 301,
respectively).

Variations

Limitations Alchemy can not write paletted files with more than 256 colors.

When reading paletted files with more than 256 colors they are
treated as true color.
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Comments Stork images are stored in two or three files (depending on
whether or not there is a color lookup table associated with the
image).  The filename given to Alchemy should be the name of
the data file (normally with a suffix of .pre); Alchemy will
generate the names of the other files by stripping the extension
and appending .idx for the index file and .tab for the color
lookup table (if any).  Alchemy will overwrite existing .idx and
.tab files without warning when creating Stork files.
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Sun Icon

Sun Icon files are used by Sun Microsystems workstations.

Extension .icon

Creator Sun Microsystems, Inc.

Sun workstationsUsed by

Sun Icon images are always 1 bit, black and white.Variations

Because Sun Icon files are actually C source code there can be
many variations of Sun Icon files.  Since adding a C
preprocessor to Alchemy to handle all the theoretically allowable
Sun Icon files is impractical we have instead designed Alchemy
to be able to read the Sun Icon files from Sun Microsystems.  If
you run across any Sun Icon files which Alchemy cannot read
please contact us.

Limitations
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Sun Raster

Sun Raster files are used by Sun Microsystems workstations.

Output Options None
Run length compression

Extension .rast

Sun Microsystems, Inc.Creator

Sun workstationsUsed by

Reads 1, 8, 24, and 32 bit Standard, BGR, RGB, and Byte
Encoded (RLE) files.

Writes 1, 8, 24, and 32 bit Standard files, and 1 and 8 bit Byte
Encoded (RLE) files.

Variations
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Limitations For a short time a version of the PBM toolkit wrote Sun Raster
files which had the wrong RGB order.  Unfortunately there seem
to be many images which were generated with this incorrect
RGB order.  Please be aware that Alchemy's Sun Raster reading
and writing capability has been extensively tested and compared
to various other tools; the RGB order we use is correct.

Comments There is no standard extension for Sun Raster files; the extension
that Alchemy uses seem to be the most common.
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Targa

Targa files were created to support the line of Targa graphics
cards.  The Targa format is popular with scanners and high end
paint packages.

Output Options Compression:
Uncompressed
Run Length Coded

Suppress footer

16 bit Override

Extension .tga

Truevision, Inc.Creator

Various scanning and paint softwareUsed by
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Variations Alchemy reads 8, 15, 16, 24, and 32 bit images, ignoring the
alpha channel for 32 bit images.

Alchemy writes 8, 15, 16, 24, and 32 bit images, writing an
empty alpha channel for 32 bit images.

Comments 15 and 16 bit output are actually the same except for one field in
the header.  The 16 bit override option causes Alchemy to write a
15 bit Targa file, with a 16 bit Targa file header.  This is
necessary for some software which can only read 16 bit Targa
files.

Targa files allow a footer containing additional information such
as aspect ratio.  However some software is unable to read Targa
files which have a footer, so Alchemy allows you to write Targa
images without a footer.  The most common variant for other
software to be able to read is 24 bit uncompressed.
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TIFF (Tagged Interchange File Format)

TIFF is designed to be a universal raster image format; it is very
popular with desktop publishing packages.

Input Options Page

Output Options Compression:
None
LZW
PackBits
Group III Fax
Group IV Fax
CCITT RLE
LZW with prediction

One Strip
Reverse Bits

.tiffExtension

Aldus Corp.
Microsoft Corp.

Creator
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Used by Various desktop publishing and scanning software

Variations Alchemy reads TIFF class B, G, R, and most class P files.

Alchemy reads 1, 4, 8, 12, 24, and 32 bit images (ignoring the
alpha channel for 32 bit images).

Input compression types supported are raw, LZW, PackBits,
Group III fax, Group IV fax, CCITT RLE (byte and word
aligned), NeXT, Thunderscan, PICIO, and SGI RLE.

Alchemy writes class B, G, P, and R files, depending on the
input file and options specified.

Alchemy writes 1, 4, 8, and 24 bit images.

Class P TIFF files can only be read if they have 1, 4, or 8 bits per
pixel.

Limitations

Group III, Group IV, and CCITT RLE compressed images must
be black and white.

If you have trouble reading a fax compressed image with other
software, you should try using the One Strip and/or Reverse Bits
options.

If there is an ICC profile available (see the section on the
Profile… dialog), it may be included in the TIFF file by selecting
the Profile box.  Alchemy will automatically read a profile, if
present, from a  TIFF file.

Comments
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US Patent

US Patent files are used by the U.S. Patent and Trademark Office
(PTO) to store and distribute patent data

Input Options Page

Extension .pat

US Patent and Trademark OfficeCreator

US Patent and Trademark OfficeUsed by

1 bit, black and white, CCITT Group 4 compressedVariations
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Utah Raster Toolkit

The Utah Raster Toolkit is a set of public domain utilities for
manipulating and converting images for various workstations.
The source code is freely available (see below).

Extension .rle

Creator The University of Utah
The University of Michigan

Utah RLE toolkitUsed by

Alchemy reads and writes 1 and 3 channel 8 bits per pixel files;
the Alpha Channel is ignored during reading.

Variations

While reading, files which are 1 channel and have either no color
map or a single channel color map are assumed to be gray-scale
images.  The single channel color map, if present, will be used as
a correction table.

Limitations

Files which are 1 channel and have a 3 channel color map are
assumed to be paletted color files.
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Files which are 3 channel are assumed to be true color.

When writing RLE files Alchemy will generate a 1 channel file
with a 3 channel color map for paletted images and a 3 channel
file with no color map for true color images.

Comments The Utah Raster Toolkit is available free of charge as pub/urt-
3.0.tar.Z via anonymous ftp from cs.utah.edu,
weedeater.math.yale.edu, or freebie.engin.umich.edu or via
floppy disk from us.
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Verity Image Format (VIF)

VIF is used by the Topic text retrieval software.

Extension .vif

Creator Verity Corp.

TopicUsed by

Alchemy reads and writes 1 bit, black and white, CCITT Group
4 compressed images.

Variations
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VIFF

Extensions .viff

Variations Reads and writes 1 bit black and white, 8 bit grayscale, 8 bit
paletted, 24 bit color, and 24 bit color with an alpha channel.

146          Image Alchemy



VITec

VITec files are used by VITec image processing software.

Extension .vit

Creator VITec

VITec ELTUsed by

Reads 8 bit grayscale and 24 bit color files, untiled and tiled
files.

Writes 8 bit grayscale and 24 bit color files untiled files.

Variations
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Vivid

Vivid is a shareware ray-tracer for MS-DOS computers.

Extension .img

Creator Steven B. Coy

Vivid Ray TracerUsed by

Reads and writes 24 bit RLE files.Variations

The Vivid Ray Tracer is a shareware program for PCs and is
available from

Stephen Coy
15205 NE 13th Pl., #2904
Bellevue, WA  98007

Comments
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Wavefront RLA

Extensions .rla

Variations Reads 24 bit color images with an alpha channel.

Image Alchemy can only read, not write, this format.Limitations
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Windows Bitmap (BMP)

Windows BMP files are used by Microsoft Windows.

Output Options None
RLE

Extension .bmp

Microsoft Corp.Creator

Microsoft WindowsUsed by

Reads 1, 4, 8, and 24 bit RGB (raw), RLE4, and RLE8 files.

Writes 1, 4, 8, and 24 bit RGB (raw), RLE4, and RLE8 files.

Variations

Limitations Several of the programs which claim to read and write RLE files
do not do so correctly; we do not recommend writing RLE files
unless you have verified that they work with your intended
application.

150          Image Alchemy



Comments Microsoft supplied Windows utilities cannot read nor write
RLE4 or RLE8 files.

If you are converting an image to use as wallpaper on a 16 color
display you will want to match the palette of the output image to
one of the existing 16 color BMP images supplied with Windows
(chess.bmp, for example).  If you do not do this the wallpaper
will not be loaded correctly.
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Windows Icon

Windows Icon files are used by Microsoft Windows.

Extension .ico

Creator Microsoft Corp.

Microsoft WindowsUsed by

Reads and write 1, 4, and 8 bit files.Variations

Windows icons always have a width and height of 16, 32, or 64
pixels (32 being the best choice, since Windows displays all
icons as 32x32).

Windows seems to remap all icons to the standard 16 colors, so
the best results can be obtained if you match the palette of your
icons to an existing icon (see the match to palette option).  If you
do not have any other icons you can also match to one of the 16
color wallpaper files supplied with Windows.

Limitations
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WordPerfect Graphic File

WordPerfect files are images which can be imported into
WordPerfect and various other word processors and desktop
publishing programs.

Extension .wpg

Creator WordPerfect Corp.

WordPerfectUsed by

1 through 8 bits per pixel are supported.Variations

In addition to raster images WordPerfect files may contain
vectors and text information.  Such information is lost when
reading WordPerfect files.  See Appendix A, Answers to
Frequently Asked Questions, for more information.

Comments
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XBM

XBM files are used by the X Windowing System.  XBM files are
C source code files which can be read and written by various X
utilities and are designed to be included in C source code for use
as icons and other bit-mapped graphic images.

Extensions .xbm

Creator MIT

The X Windowing systemUsed by

1 bit per pixelVariations
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Limitations Because .xbm files are actually C source code files there can be
many variations of .xbm files.  Since adding a C preprocessor to
Alchemy to handle all the theoretically allowable .xbm files is
impractical we have instead designed Alchemy to interchange
.xbm files with the PBM utilities and the X supplied utilities, and
to read the sample .xbm files from Sun Microsystems.  If you run
across any .xbm files which Alchemy cannot read please contact
us.

The hotspot field is ignored when reading .xbm files.

Comments Most of the X supplied utilities (bitmap, for example) are
designed to edit small .xbm images.
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XIM

Extensions .xim

Variations Reads and writes 8 bit paletted, 24 bit color, and 24 bit color
with an alpha channel.

156          Image Alchemy



XPM

XPM files are used by the X Windowing System.  XPM files are
C source code files which can be read and written by various X
utilities and are designed to be included in C source code for use
as icons and other bit-mapped graphic images.

Output Variations Type:
XBM Style
XPM
XPM2

48 Bit

Extensions .xpm

MITCreator

The X Windowing systemUsed by

8 bits per pixelVariations
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Limitations Because .xpm files are actually C source code files there can be
many variations of .xpm files.  Since adding a C preprocessor to
Alchemy to handle all the theoretically allowable .xpm files is
impractical we have instead designed Alchemy to interchange
.xpm files with the PBM utilities and the X supplied utilities, and
to read the sample .xpm files from IBM.  If you run across any
.xpm files which Alchemy cannot read please contact us.

Some XPM files contain color names instead of color values for
some of the colors.  The conversion table of these names into
values is in a file supplied with the X Windowing system called
rgb.txt.

Comments The different type XPM files can be identified as follows:

Type 0:
#define type0_format 1
...
static char *type0_colors[] = {
"a", "#000000",
 ...

Type 1:
/* XPM */
static char * type1[] = {
"32 20 12 1",
"a c #000000",
...

Type 2:
! XPM2
32 20 12 1
a c #000000
..
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When writing an XPM file with less than 27 colors Alchemy
writes 1 character XPM files, otherwise Alchemy writes 2
character XPM files.

XPM files are usually quite small, therefore many utilities (the
PBM toolkit for example) may have trouble reading large XPM
files.
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XWD

XWD is the file format used by xwd, the X Windowing System
dumping utility.

Output options Z format
XY format

Extension .xwd

MITCreator

The X Windowing SystemUsed by

Alchemy reads 1, 4, 8, and 24 bits per pixel Z format and 1, 4,
and 8 bit XY format XWD files.

Alchemy writes 1, 8, and 24 bits per pixel Z format and 1 and 8
bit XY format XWD files.

Variations
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5

The File Menu:  Other Commands

Introduction The File menu also handles other standard image file
management features, such as Close, Revert to Saved, Page
Setup, Print, and Quit.

Close The Close feature closes open windows.

The Revert to Saved feature causes all changes made to an image
since the last time it was saved to be undone.

Revert to Saved

Page Setup is the standard window allowing you to change
parameters for printing, such as paper selection, layout,
reduce/enlarge, and orientation.

These functions are not performed by Image Alchemy, but are
intrinsic to your system.  Depending on your printer driver, you
may achieve better results by having Image Alchemy perform
the scaling than choosing reduce/enlarge from the Page Setup
menu.

Page Setup

Image Alchemy           161



Print Print allows you to access the functions native to your printer
when you print your file, such as the number of copies you
would like and the paper cassette your printer will use.

These functions are not performed by Image Alchemy, but are
intrinsic to your printer.

Quit Quit causes all Image Alchemy windows to close and Image
Alchemy to stop running.
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The Edit Menu
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6

The Edit Menu

Introduction The Editmenu handles standard Mac copy and paste operations.

Undo The Undocommand undoes the last operation.

The Cutcommand copies the selected region to the clipboard,
and deletes it.  This is only functional in text fields.

Cut

The Copycommand copies the selected region to the clipboard.
This works in text fields and with selected regions of an image.

Copy

The Pastecommand pastes the contents of the clipboard at the
current insertion point.  This is only functional in text fields.

Paste

The Clear command deletes the selected region.  This is only
functional in text fields.

Clear
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The Image Menu
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7

  The Image Menu – Color Management:  Adjust
Palette, Invert, and Profile

Introduction The image menu is used to change those settings which affect the
appearance an image.  Color controls fall into two broad
categories: palette manipulation and profiles.

Generally speaking, palette manipulation features are for
multimedia designers and people creating content for the world
wide web. They control things like the number of colors in the
output image, and the  method used to change color spaces.
Image enhancement features include convolutions and histogram
operations.

Profiles are well suited for achieving accurate color on printers
and plotters. Image Alchemy supports profiles for scanners,
monitors, printers, and plotters.

Managing color information, palettes, dithering and profiles will
be discussed in the following pages.
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Colors

The number of colors a converted image will have can be set
with the Adjust Palette dialog.  The number of colors in the
image will be between 2 and 256 for a paletted image and in the
thousands for true color images with 15 or 16 bits per pixel, or in
the millions for images with 24 or 32 bits per pixel.

To change the number of colors in an image, select the number
of colors you would like to have in the image you produce.  If
you would like to change from a color image to a gray image,
select “Color” or “Gray” in the dialog box.

To change a true color image to a 256 color image, set up the
dialog box as above by selecting 256.

Color and Dithering You may  also want to choose a dithering type whenever you
decrease the number of colors for your new image.  Please read
the section below, “ Dithering,” which will explain the tradeoffs
of the different types of dithers.

Note that if you increase the number of colors in an image
beyond what was in the original image, the new image will not
actually have more colors. However, the image will be
recognized by your application software as having more colors
than it originally did (which is useful for compatibility reasons).

2 / 16 /
256/Choose…

Each of these options specifies a certain number of colors to be
used in the output file.  Note that specifying any of these options
will generate a paletted output file, as opposed to a true color
file.
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16 (4 bit CMYK) This option will produce a CMYK image with 1 bit per
component.

256 (16 bit GA) This option is similar to 256 colors with Grays selected, but
includes an alpha channel.

Thousands (15 bits) Specifying this option will make the output file a 15-bit image,
with 5 bits each for the red, green, and blue fields.  This yields a
total of 32,768 possible different colors.

In this case, the output file will retain 16-bits of color
information per pixel (5 bits for red and blue, and 6 bits for
green), yielding a total of 65,536 possible different colors.

Thousands (16 bits)

This option will yield an output file with 8 bits of information
per color, for a total of 24 bits per pixel.  With this combination,
16.7 million colors are possible.

Millions (24 bits)

This option is similar to the 24-bit option; it also has 8 bits of
information for the red, green, and blue components.
Additionally, though, it has 8 bits of information available for an
alpha channel, which is used by some file formats to store
auxiliary information such as text, texture characteristics, etc.

Millions (32 bit
RGBA)

This option will yield an output file with 8 bits of information
per color in CMYK mode for a total of 32 bits per pixel.

Millions (32 bit
CMYK)

Whenever 256 or fewer colors are selected in the Adjust Palette
dialog box, a method of choosing a palette must be specified.

Palette

If you start with a color image and reduce the number of colors
Alchemy will default to using Heckbert quantization.

Default
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Heckbert Use the Heckbert color quantization technique to generate the
new palette.  This creates a custom palette for the image based
on the colors which are used in the image.  It produces the best
results when converting a true color image to a paletted image or
reducing the number of colors in a paletted image.

Uniform Instead of using the Heckbert algorithm to generate a custom
palette for the image, use a palette with entries which are evenly
distributed across the spectrum (of the RGB color cube).

The advantage of using a uniform palette is that it is faster than
generating a custom palette.  However, this is at the expense of
image quality since the palette is not generated based on image
content.

The choose... option described above in the section on colors can
be used in conjunction with a uniform palette to specify the size
of the uniform palette; in that case Alchemy will generate a
palette with not more than the specified number of colors (but
not less than 8).  The palette size will not necessarily match the
specified size, as the actual size must be the product of three
integers.  Alchemy picks integers that roughly correspond to the
sensitivity of the human eye to red, green, and blue (30%, 59%,
and 11%).
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Custom… This brings up an additional dialog that allows you to: load a
palette from a file; edit individual palette entries; or specify
entries that Alchemy will not use in the final image.

Single palette entries may be selected by clicking on them, and
ranges may be selected by dragging.  Load… loads a palette
from a file.  Save… saves a palette to a file.  Blend creates a
linear ramp between the end colors in the current selection.
Swap swaps the two end colors in the current selection, and
Reverse reverses the order of all of the colors in the current
selection.  Pick… allows you to select a new color for the
currently selected entry..

Map to Palette causes Alchemy to map the image to the new
palette.  False Color cause Alchemy to use the new palette in
place of the original, if any.

Transparent marks or unmarks the currently selected entry with a
'T'.  At most one entry can be transparent. Transparency is only
currently used by GIF and PNG output.

Locked instructs Alchemy to not modify this entry.  Palette
entries that are not locked may be replaced by colors generated
from the original image.

Don't Use instructs Alchemy to not map the image to this entry.
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EGA Palette When this option is enabled, Alchemy will optimize the image
quality for display on an IBM PC EGA board and monitor.
Alchemy does this by reducing the palette resolution to two bits
and modifying the manner in which the palette is generated.

Dither Dithering is used to reduce color banding in an image caused by
the palette not having a perfect match for every color in the
image.

Dither Types Floyd-Steinberg through Sierra Lite are all error-diffusion
dithers.  Floyd-Steinberg and Sierra Lite are the fastest of the
diffusion dithers, and they usually look the best on low
resolution devices like computer monitors (CRTs).  Stucki,
Jarvis, Judice & Ninke, and Stevenson and Arce all tend to cause
an image to appear more grainy on monitors;  however, they
produce better results than Floyd-Steinberg or Sierra Lite on
high-resolution, low color output devices such as laser printers
and inkjet plotters.

The Halftone option will produce the most accurate grays on a
laser printer, but the image will not be as sharp as one produced
by the error-diffusion dithers.  Bayer is a dispersed dot ordered
dither; its only advantage over the error-diffusion algorithms is
speed.

The dither option only has an effect if the number of colors is
being reduced or the image is being re-mapped to a new palette.

Using a serpentine raster can help to reduce visible patterns
introduced by dithering.  Using a serpentine raster has no effect
when Halftone or Bayer dither types are used.

Serpentine
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Perturbation Specifying a perturbation adds noise to the image, which can
help break up visible patterns introduced by dithering.  The
parameter specifies the magnitude of the noise, with valid values
being between 0 and 127.  Perturbation has no effect on Halftone
or Bayer dither types.

Invert This is equivalent to a photographic negative.  When used on
black and white images black is changed to white and white is
changed to black.  On color images each of the Red, Green, and
Blue channels are inverted separately (so that bright blue will
become bright yellow, etc.)
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Profile…

The Golden Rule The Golden Rule of Profiling: define the process; profile the
process; use the process.  If the Golden Rule of Profiling is not
followed you can produce worse results than if you had not
touched profiles at all.

If the process is scanning a picture and printing it, then you will
want to get or make a profile for the scanner and printer, and use
them.

Before trying to use the profile feature you should read the
material available at http://colorsync.apple.com.  This is a
valuable resource for finding people who will make profiles for
you.  You will also find a variety of hardware and software for
making your own profiles.  The site provides accurate and useful
information.

Profiles can be generated with third party device profiling
systems. Sometimes profiles are provided by hardware
manufacturers for their devices. A profile provided with your
scanner will most likely be fairly accurate and useful. Profiles
provided with color printers can be useful if they are for the
exact combination of ink and paper that you are using. Profiles
provided with monitors are useless if the monitor is adjusted
incorrectly.
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Selecting Profiles

Alchemy can use ColorSync to convert colors so that they will
be reproduced on profiled devices more accurately.  Use the
Profiles dialog to choose profiles for the device that created your
image and the one that the image will end up on.  For example,
under source you could specify the profile for your scanner and
under destination you could specify the profile for your printer.

The System profile is the one selected in the Apple supplied
control panel "ColorSync System Profile".  This should be set to
match your monitor.

Embedded refers to a profile included in a file.  Usually this will
appear grayed out. If you open a file that has a profile included
in it then embedded will not be grayed out.

In the Destination profile menu, Source instructs Alchemy to use
the profile that is specified for the Source image, if any.

Specify… in either profile menu allows you to choose a file
containing a profile.  When you select one for the Source image,
Alchemy will only show you profiles that are appropriate for the
colorspace the source image is in.  You can override this, so that
you may select any profile, by holding down the option key
while selecting the Specify… menu item.

Anytime you select a destination profile, the Adjust Palette…
dialog will be automatically updated to a colorspace that is
appropriate for the profile you selected.  You may then go to the
Adjust Palette… dialog to override those settings.
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8

Image Enhancement: Convolve, Gamma
Correction, Brightness & Contrast, Histogram,
and Set Resolution

Introduction The Convolve, Gamma Correction, Brightness and Contrast,
Histogram , and Set Resolution options are used to change to
appearance of the image.
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Convolve The convolve option can be used to apply any one of a number
of convolutions to an image (such as sharpen or blur).
Convolutions are mathematical transformations which are not
necessarily reversible  You can “undo” a convolution, since
Image Alchemy will remember what the original image was.
However, Blurring a Sharpened image will not give you the
original image back.

Image Alchemy includes three filters, and these should be seen
on your Convolution sub menu (which is found under your
Image Menu).  See the Options section to specify the directory in
which convolutions are stored.

Understanding
Convolutions

The best way to understand what these features do is to use them.
You can also create your own convolutions, as described in the
Specify… section.

Described below are the convolution filters which have shipped
with Image Alchemy.

Sharpen Sharpen uses a photographic technique called “Unsharp
Masking” to make the edges in an image more distinct.

Blur makes an image less sharp.Blur

Edge Detection finds and highlights the edges in an image.  The
parts of the image which are not edges are dark.

Edge Detection
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Specify... This feature allows you to specify a convolution.  The
Convolution dialog box allows you to create a series of rows and
columns, which is called a matrix.

Convolutions are very complicated, but that should not stop you
from playing around!

To give you some idea of what is happening:  Each pixel on the
screen has an "intensity".  If you pick 9 pixels arranged like a tic-
tac-toe board, then you pick 9 numbers arranged in a different
tic-tac-toe board, you can begin to see how convolutions work in
this way:

Pick the middle pixel of your tic-tac-toe board.  Then see what
the middle number is and imagine "multiplying" the intensity of
that pixel by that number.  Looking to the pixel directly to the
left of center, apply the number directly to the left to see how
intense that pixel will now be.  Do this for all nine pixels and add
the results.  The final result is the intensity of the pixel in the
new image that corresponds to the one under the center of the
convolution matrix.

But that is not the end of the story, since now you move the tic-
tac-toe board over one pixel and do the same thing again.  Repeat
for every pixel in the image.

So, convolutions can be very confusing to think about.  You
might be best advised to simply experiment with different
matrices.  Remember that the larger the matrix, the longer the
calculation time.
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Brightness

Increases or decreases the brightness of an image by adding a
constant to each of the pixels.

Contrast Increases or decreases the contrast of an image by multiplying
each of the pixels by a constant.

Gamma
Correction

Gamma correction increases or decreases the gamma value of an
image.  This controls the brightness/contrast of an image in a
non-linear fashion.  The gamma values range between 0.25 and
4.00.   Use "preview" to experiment with input and output
gamma.

Input Gamma and
Output Gamma

Enables gamma changes by taking into account the gamma value
stored in the image.  The gamma dialog can be used to change
the value stored in some file formats without changing the actual
image data by leaving Use Gamma off.

Use Gamma
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Histogram Histogram enhances an image contrast by stretching the pixel
color values to the full 0 to 255 range.

Histogram Types Spiff, ensures that the image has pixels which are distributed
over the entire intensity range .

Equalization insures that the distribution of pixels over the
output range is linear.

Equalization can produce significantly better results than Spiff
for some images.  Generally you will want to try both types to
see which gives better results.

Set Resolution Sets the resolution of the image.  The default units are controlled
by the General Options dialog.  You may override the default
units by following the number with a 'i' for dots per inch, 'c' for
dots per centimeter, or 'm' for dots per millimeter.
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9

Resize and Crop

Introduction The Image menu has two submenus, Resize Image… and Crop
Image…, that are used to change the size of an image.  Resize
changes the size of an image by scaling and Crop changes the
size by removing part of the image (cropping ) the image.

Resize

Specify the final image heightand width , in pixels, inches, or
centimeters. The height and width values can also be changed by
changing the size of the window the image is displayed in.  To
change the size of the window place the mouse cursor on one of
the corners of the panel.  Then, while pushing down on the
mouse button, drag the corner to change the size of the window.
You may override the default units by following the numbers
with 'i' for inches, 'c' for centimeters, 'm' for millimeters, or 'p' for
pixels.

Height and Width

When set to Preserve Aspect Ratio, the given values will act as a
bounding box, reducing one dimension if necessary to preserve
the image aspect ratio.  In other words, the image will be no
larger than the height and width entered.

Aspect
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Scaling When the size of the image is being changed, Alchemy can use
any of four different algorithms to perform the scaling.  They are
listed in order of quality.  Nearest neighbor will produce the
fastest transformation, but the resulting image will suffer from
aliasing.  Alternatively, Lanczos 3 will produce exceptional
results, but processing time is longer.  Linear Interpolation is the
best tradeoff of quality versus time.

All of the scale types other than nearest neighbor give good
results but they are slower and require a new palette to be
generated for paletted output files. You can force Alchemy to use
the original palette by using the Load from File option in the
Adjust Palette dialog and specifying the original image as the
palette file.

Example In the above example, the given image will be scaled to a width
of 5 inches, height of 4.39 inches, using the Linear Interpolation
algorithm.
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Crop

You can use the mouse to select the area you want and then
press the crop button, or you can enter specific values. The
default units are as specified in the General Options dialog.
You can override the default units by following the
numbers with 'i' for inches, 'c' for centimeters, 'm' for
millimeters, or 'p' for pixels.

Top This value specifies the number of pixels from the top of the
image to begin the cropping procedure.  If set to 0, any reduction
in the height of the image will be from the bottom.

Left This value specifies the number of pixels from the left of the
image to begin cropping.  If set to 0, any reduction in width of
the image will be from the right.

This value specifies the number of pixels from the top of the
image to end the cropping procedure.

Bottom

This value specifies the number of pixels from the left of the
image to end cropping

Right

The value entered here determines the final width of the image,
in pixels.  The Left value (described above) determines whether
the cropped pixels will be from the left, right, or some
combination.

Width

The value entered here determines the final height of the image,
in pixels.  The Top value (described above) determines whether
the cropped pixels will be from the top, bottom, or some
combination.

Height
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Using the Mouse Rather than typing specific values for the final width and height,
and having to figure out how many pixels to remove from each
side, the mouse can be used to select a portion of the image.
Once the image has been loaded and displayed on the screen, the
mouse button can be used to visually select a portion of the
image to crop; the values in the Crop Window will automatically
be updated to reflect the selection made.  At this point, simply
clicking the Crop button will execute the command.

Example In the example given above, the resulting image will contain the
upper left 5 x 4.39 inches of the original image.
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The Display Menu
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10

The Display Menu

Introduction The Display menu allows the user to control the display of the
image on the screen.  It does not alter the actual image file, just
what you are seeing on your monitor.

Show Image When Show Image is selected, the image will be displayed.
When it is not selected, it will not be displayed.  Having the
ability to turn the display off is helpful for processing large
numbers of images, particularly when using the Script functions,
since time spent displaying the image can be avoided.  If you
cancel a conversion, it will automatically cause the image to not
be displayed.  You must select Show Image again for the
previous image to be reloaded.

Enlarge automatically enlarges the viewed image 200% (twice
the size).

Enlarge

Reduce automatically reduces the viewed image 50% (half the
size).

Reduce

Using this option the user can enter the amount of magnification
desired:.400% (4X magnification), 200% (2X magnification),
Normal (1X magnification), 50% (reduce to half), or 25%
(reduce to one-quarter).

Set Magnification

Using Pose allows the image to fill the entire monitor for
viewing.  To leave Pose, click the mouse anywhere or press any
key.

Pose
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The Scripts Menu

Image Alchemy           193



194          Image Alchemy



11

Scripting

Introduction The Scripting capabilities of Image Alchemy allows the user to
automate commonly used conversions.

Record Script To record, select Record Script under the Scripts menu.  The
apple icon on the title bar will now flash as a cassette.  If the
cassette does not flash, check that you have the AppleScript
extension installed.  From that point, simply select the items you
wish to perform and Image Alchemy will record the sequence.  It
is a good idea to have planned any complex sequence before
recording it.  When you have completed performing your
sequence, select Stop Recording from the Scripts menu.  You
will then get a dialog box asking you to save the script.  Enter the
script name, select the appropriate location, and press save.

Selecting Execute Script will bring up a dialog box which allows
you to find and select existing scripts.

Execute Script
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Answers to Frequently Asked Questions

How do I generate a single palette from a
collection of images, and map all of those images
to the new palette?

Question

Answer This can be done with the Cumulative Histogram format.  First,
open all of your images using Open Several….  Now, do an
Append to New File…, selecting Cum. Histogram as the format.
Next, open the resulting histogram file (the image data will not
look like anything useful, but it does represent all of the colors
used by the original images).  Save that file in a paletted format,
such as HSI Palette (if you want fewer than 256 colors in the
palette, select that first in the Adjust Palette… dialog).  Finally,
select the window containing your original images and bring up
the Adjust Palette… dialog.   Select 256 colors, and Custom… in
the Palette menu.  From the Custom… dialog, push Load …, and
select the palette file you created earlier.  Select OK in the
Custom… dialog, and Apply… in the Adjust Palette… dialog.

This process can be combined with other palette selection
features to do things like generating a custom palette for a
collection of images, but with the first and last ten colors fixed.
Just use the Adjust Palette:Custom… dialog before converting
the cumulative histogram into a palette file to select colors that
you do not want changed.
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Question Why do I get garbled output when I try to send
PCL data to my printer through my Axis print
server in AppleTalk mode?

Answer There is one possible complication with AppleTalk output.  The
protocol is usually used to communicate with PostScript devices,
and PostScript has different methods for sending binary data
over a network and over a parallel/serial port.  Because of this,
some print servers perform conversion between the protocols
internally; this will prevent the server from working correctly
with non-PostScript data.  So far we have tested the NetQue
pocket print server from Emulex Corporation, and the Axis 540+
from Axis Communications. The NetQue does not currently
perform this conversion, so it works as is.  The Axis does, but
that conversion can be turned off.  To do this, follow the
directions in the Axis manual (on page 67 for Revision 2.1) - the
option you need is 'BINARY: NO'.  You do not need to specify a
BINARY_TYPE command.

Question Why can't my paint package read the Targa file I
wrote with Image Alchemy?

Some software which reads Targa files cannot handle
compressed files.  In addition, some software can read true color
Targa files, but cannot read paletted or gray-scale files.  You
should try writing an uncompressed, 24 bit Targa file.

Answer
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Question I'm using Alchemy to produce an HP RTL file to
be printed.  The print is much darker than the
original image.  Why is this?

Answer The solution is to perform gamma correction or see the section
about using profiles. Many hard copy output devices, including
laser printers, ink jet printers, and ink jet plotters, have a
property known as dot gain.  Dot gain causes more toner or ink
to be placed on the paper than is expected.  This is caused by the
fact that the individual pixels being output are round, and in
order to completely fill in a square grid with round pixels the
round pixels have to be larger than the square (in fact the circle
has π/2 times as much area as the square).  In this example of a
single pixel the black area represents the "extra" toner or ink that
is being printed:

You can compensate for dot gain by adjusting the gamma of the
image during the conversion process.  The exact gamma value
will depend on the output device, but in general, specifying an
output gamma of 2.0 produces good results.
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It is not as necessary to compensate for dot gain when printing at
a resolution less than the printer's maximum resolution.  This is
because the output device automatically groups individual pixels
together to make the output pixel, which reduces the amount of
extra toner or ink being deposited on the page, as in this example
of printing a 150 DPI pixel on a 300 DPI device:

The same is true if you are using a Clustered Dot dither (since
that dithering type cluster the dots).

Question Why can't my favorite desktop publishing
package read the TIFF file I wrote with Image
Alchemy?

Answer TIFF (Tagged Interchange File Format) is an extremely versatile
standard; it can handle anything from 1 bit images to full color
images with an alpha channel.  Also, TIFF allows many different
types of compression.  Unfortunately this versatility means that it
is difficult for a single piece of software to be able to read in
every valid TIFF file.
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If the software specifies the classes of TIFF it can read, you can
force Alchemy to write out a specific TIFF class by using the
following options:

 B: Black and white/2 color/PackBits compression
 G: Black and white/256 color/No compression
 P: 256 color/No compression
 R: 24 bit color/No compression

Class B is black and white, Class G is gray-scale, Class P is
paletted, and Class R is true color.

If the supported classes are not specified, experiment with black
and white, gray-scale, and color.  In this case it is usually best to
use no compression while experimenting with the other options,
as many TIFF readers have difficulty with compressed files.
When you find a set of options that work, then you can try
various compression modes to save space.

You may also have to specify the resolution of the image (this is
especially true when converting from a file format which does
not have a value for image resolution).  You can generally tell if
this is necessary because the program you are using to read in the
TIFF file will claim that the file is unreasonably large or small.
Generally, if you are using a 300 DPI Laser Printer you want to
make the TIFF file 300DPI x 300DPI.
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Question When I convert a GIF file to a JPEG file and then
back to a GIF file the final GIF file is twice the size
of the original.  Why is this?

Answer There are two things which might cause this to happen:

JPEG compression does not really work well for images which
have large areas which are all the same color.  The reason for
this is that JPEG is a lossy compression technique.  Therefore
you are not going to get back exactly the same values for each
pixel in an area that was one solid color before being JPEG
compressed.  But GIF compression works much better on areas
which are one solid color, so, when you GIF compress these
areas, they are quite a bit larger than they were before.  The
solution to this problem is to use HSI JPEG compression, which
automatically detects large areas of solid colors and does not
JPEG compress them.  The problem with HSI JPEG compression
is that it is not compatible with JPEG or JFIF.

The other possibility is that the input GIF file did not have very
many different colors.  When you converted it to a JPEG file the
number of colors in the file was lost (JPEG gray-scale files
always use 256 shades, and JPEG color files are always true
color).  When the JPEG file was converted back to a GIF file
Alchemy assumed you wanted 256 colors in the file, and a 256
color GIF file is bigger than a 16 color GIF file.
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Question Why can't Image Alchemy read in JPEG files
produced by Kodak's ColorSqueeze (or Sun's
VFCtool)?

Answer Some software packages support an obsolete version of JPEG.
Image Alchemy supports the JFIF format and should work with
any other JPEG software which also claims JFIF compatibility.
If other software you are using claims to support the JFIF format
and you are having trouble, please contact us.  If the other
software does not support JFIF, contact the manufacturer and tell
them they should send you an update which does (you can tell
them to contact us if they need a copy of the JFIF standard).

Question I've loaded a HP PCL file but some or all of the
information that was in the file is missing.  What
happened to it?

PCL files can be a combination of text, fonts, drawing
commands (such as lines and rectangles), and graphics (also
called rasters). Alchemy can only convert the raster areas in PCL
files.  Unfortunately there is not any general way to preserve the
rest of the data with Alchemy.

Answer

If you are producing the PCL files using Windows 3.1 and
printing using TrueType fonts you can select the Print TrueType
As Graphics check box in the printer setup dialog box under the
Options choice.  This will cause Windows to print all
information as graphics which Alchemy can then successfully
convert.
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Question When I convert a 32 bit Targa file to a GIF file
and then to a JPEG file it does not look nearly as
good as if I convert the Targa File directly to the
JPEG file.  What can I do to maintain high quality
in JPEG compressed files?

Answer When the Targa file was converted to the GIF file Image
Alchemy had to reduce the number of colors in the file (the
original Targa File had up to 16 million colors, GIF files are
limited to 256 colors).  This step is known as color quantization
(Image Alchemy uses the Heckbert Median Cut method for
quantization; see Appendix B, Color and Dithering, for more
information).  The difficulty with color quantization is that it
leaves artifacts known as color banding.  To reduce this
phenomenon Image Alchemy dithers the image (you can see the
effect of color banding by turning off dithering).  Unfortunately a
dithered image does not JPEG compress very well (dithering
adds a lot of high-frequency information to an image; JPEG
compression attempts to remove much of that information).  In
addition JPEG images are always continuous color images, so
when the JPEG file is decompressed it has to be color quantized
and dithered again.  Dithering a previously dithered image
reduces the quality even more.  The solution is to use the best
starting quality you can for JPEG compression, ideally a
continuous tone image.  The compressed image size will be
smaller than if you had started with a paletted image and the
quality will be better.
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Question I converted a PCX file with 16 shades of gray and
saved it as a TIFF file.  The 16 color PCX file had
some shades of gray in it which were changed in
the TIFF file.  How can I prevent this?

The problem is that gray-scale TIFF files have a uniformly
spaced gray palette.  However the 16 color PCX file you started
with probably did not have those exact colors in it (for example,
PCX files written out by Windows 3.0 Paint have shades of gray
which correspond to 0, 128, 192, and 255).  So Alchemy did the
best it could and matched the input colors to the output colors
(and depending on the other options that you specified may also
have dithered the image).

Answer

The solution is to tell Alchemy to write out a 256 color gray-
scale TIFF file.  This file still has a uniform gray palette; but that
palette now contains every color:  0, 1, 2, 3, …, 255.  Therefore
Alchemy can map, for example, the colors 128 and 192 to their
exact match.  This does have the disadvantage of making the
resulting 256 color TIFF file twice as large as the 16 color TIFF
file, but this is the only way to guarantee that Alchemy can find
an exact match for all the shades of gray in the input file.

How do I get a copy of the JPEG standard?Question

The JPEG standard is an ISO/IEC standard and you should
contact your local ISO/IEC office to get a copy.  The document
number is ISO IS 10918-1.

In the United States you can contact ANSI at:
ANSI
11 West 42nd St.
New York, NY  10036
(212) 642-4900

Answer
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B

Color and Dithering

Paletted vs.
True Color

Color images are normally stored in one of two ways: as an array
of direct color values (usually red, green, and blue) (referred to
as a true color file in this document) or as an array of indices into
a color-map which contains red, green, and blue color values
(referred to as a paletted file in this document).

The reason for the existence of paletted images is that they take
less memory, so the hardware to display them is less expensive.
The dominance of paletted hardware is changing as the price of
memory and the processing power it takes to update large
amounts of memory at a reasonable speed drops.

Until true color graphics devices become the norm there is a
need to convert images from true color to paletted.  This
conversion is done in two steps: the first is to generate a palette
for use by the image;  the second is to map the image to the new
palette.

Color cube The color model generally used by computers is a cube with red,
green, and blue as the axes (this is known as a color cube or
RGB cube).  Each point inside the cube is a different color,
depending on the amount of red, green, and blue used.  In nature
each of the three axes is nearly continuous, therefore there are
many colors available.  Computer hardware and software
represent colors in a discrete fashion.
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For true color displays or file formats the number of discrete
positions along each axis of the color cube gives the color
resolution of the output device.  For example, a Targa 24 board
for an IBM PC has 8 bits per red, green, and blue channel for a
total of 24 bits (or 256 discrete shades of each color, for a total of
16 million colors (256x256x256)).  This is also the color
resolution of most true color file formats.

15 bit SVGA boards have 5 bits per channel, for a total of
32x32x32 different colors (32,768).  This is the same color
resolution as a Targa 15 file.

A paletted display or image file has the same color resolution
limit as a true color display or image file, but in addition there is
a limit on how many points inside the cube can be used at the
same time.  An 8 bit file format, such as GIF, allows 256
different colors out of 16 million.  A normal SVGA board also
only allows 256 different colors at one time.

So, converting a true color file to a paletted file involves
reducing the number of occupied points in the color cube.  There
are several ways this can be done.

Image Alchemy supports two methods of generating a palette:Generating a
palette

The simplest and fastest method is to use a palette containing
colors which are uniformly distributed in the RGB cube, referred
to as a uniform palette.  This has the advantage that it is fast and
the same palette can be used for any image; the primary
disadvantage is that most images do not contain colors from
everywhere in the RGB cube, so palette entries are wasted
representing colors that are not needed for the particular image
being converted.

Uniform palettes
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Optimal palettes To generate a palette which is better for representing a particular
image, Image Alchemy supports Heckbert's median cut
algorithm.  This algorithm first builds a three dimensional table
(a histogram cube) indicating how popular any given color in the
RGB cube is in the image being converted.  It then proceeds to
subdivide this histogram cube (by dividing boxes in half) until it
has created as many boxes as there are palette entries.  The
decision as to where to divide a box is based on the distribution
of colors within the box.  This algorithm attempts to create boxes
which have approximately equal popularity in the image.

Palette entries are then assigned to represent each box.  There are
other methods of generating a palette from an image, but
Heckbert's algorithm is generally regarded as the best tradeoff
between speed and quality.

Mapping the image
to the palette

The next step is to map the image to the new palette; this is
where dithering becomes important.

The simplest approach is to map every color in the original
image to the palette entry which is closest to it (this is what
Image Alchemy does if you specify no dithering).

No dithering

However, since the palette entries generally represent several
different colors in the original image, this results in color
banding, where areas of smooth color changes in the original
become areas of one solid color in the paletted version.

This can be alleviated by dithering the image data such that any
given pixel might not be mapped to its closest palette entry, but
the average over some area of the image will be closer to the
correct color than it would otherwise be.  Image Alchemy uses a
class of algorithms called "error-diffusion" to do dithering.

Advantages of
dithering
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Error diffusion
dithering

These algorithms work by using the closest palette entry to a
color and then distributing the error (the difference between the
desired color and the chosen palette entry) to the nearby pixels.
This process is repeated for every pixel in the image, using the
color values which have been modified due to the error from
previous pixels.  The different dithering algorithms spread the
error over a different area or use a different weighting within the
same area.

Serpentine raster Error diffusion can be done as a normal raster (left to right, top
to bottom) or as a serpentine raster (alternating left to right and
right to left, top to bottom).  A serpentine raster tends to break up
visible patterns introduced by dithering.

Noise Random noise can also be added to help break up visible patterns
in the resulting image.

For more information on Heckbert's median cut and dithering see
the appropriate reference listed in the References section below.

Further
information
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What is JPEG Compression?

Who are those
JPEG guys?

JPEG stands for the "Joint Photographic Experts Group."  This is
a group of experts who defined a standard compression scheme
for still images, commonly called JPEG Compression.

Overview JPEG Compression consists of a series of reasonably complex
mathematical operations.  These include: color space conversion,
discrete cosine transforms, quantization, and entropy coding.
After these steps you end up with an image which takes fewer
bits to store than you started out with.

However, when you decompress a JPEG compressed image you
end up with an image that is not quite the same as the original
(which is why JPEG Compression is referred to as "lossy").

You might well ask why anyone would want to compress an
image using a lossy technique.  Compression ratios for lossy
compression are much better than for lossless compression and
the loss is generally very small.  And, in fact, every operation of
converting an image is lossy (the original photographic or
electronic process which captured the image was lossy, scanning
or digitizing the image was lossy, displaying the image on a
monitor is lossy, and printing the image is lossy).

Is lossy
compression bad?
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Details JPEG compression involves the following steps:

Step 1 The image is converted to a color space with separate luminance
and chrominance channels.  This is done because the human eye
is far more sensitive to the luminance information (Y) than it is
to the chrominance information (Cb and Cr); by separating them,
it is possible to compress the chrominance information more than
the luminance before the perceived image quality suffers.

This step is not specified in the JPEG draft (it does not discuss
color space at all), but is standard practice.  Image Alchemy uses
CCIR-601 YCbCr, which is the color space specified by the JFIF
standard.

Step 2 The luminance and chrominance information are separately
transformed to the frequency domain using a discrete cosine
transform acting on 8x8 pixel blocks.

To reduce the amount of data which needs to be compressed the
chrominance information may be sub-sampled first.  Alchemy
uses 2h:1v:1h:1v:1h:1v sub-sampling when writing JPEG files,
which means that the first component (luminance) has twice as
many samples horizontally as the other two components
(chrominance), and the same number of samples vertically.
Alchemy can read JPEG files with any sub-sampling allowed by
the standard.
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Step 3 The transformed data is quantized (so some information is
thrown away).  The samples representing higher frequencies are
generally quantized using larger steps than those representing
low frequencies.

The quality level you specify is used to scale a set of
quantization values which have been found to cause the
quantized data to all have approximately equal importance
visually.  A lower quality number will cause larger quantization
steps to be used, and hence increase the compression ratio and
decrease the image quality.

Step 4 The quantized data is compressed using an entropy coder;
Huffman and Arithmetic coding are allowed by the draft JPEG
standard; only Huffman coding is allowed by the JFIF standard.
Huffman coding can either be done with a set of fixed tables or
custom tables can be generated for an image.  Alchemy, by
default, uses a fixed set of tables, but can also generate custom
tables which usually produce 5-20% better compression
(depending on the image and quality setting).  However,
producing custom tables requires an additional pass over the
image data and therefore takes a little longer.

JPEG Interchange
Format

This data corresponds to the JPEG Interchange Format and is
ready to be stored in a file.  Unfortunately the JPEG Interchange
Format does not include enough information to actually be able
to convert the file back to an image.  Specifically the color space
used and the aspect ratio or resolution of the image are not
included.
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JFIF On March 1, 1991 representatives of several JPEG hardware and
software developers (including C-Cube, Radius, NeXT, Storm
Tech., the PD JPEG group, Sun, and Handmade Software) met at
C-Cube and established the JPEG File Interchange Format
(JFIF).  If you would like more information on the JFIF standard
please contact us.
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D

Customer Support

Why might
Alchemy mess up?

We have made every effort to insure that Image Alchemy can
read all files in its supported formats.  However, because of
poorly written standards and non-adherence to standards there
are undoubtedly certain files that Image Alchemy does not read
correctly.

What we need to
help you

If you come across any files which Image Alchemy has trouble
with, please contact us with as much of the following
information as you have: version of Image Alchemy you are
using, type of file, type of computer which generated it, name
and version of software which wrote the file, size of image, and
the number of colors in image.  We may ask you to send us the
file so that we can figure out what went wrong.  If you send us a
file we will attempt to modify Image Alchemy so that it can read
the file.  Once Alchemy is modified, we will send you an
updated copy of it.

Similarly, if any files that Image Alchemy writes cannot be read
by other software please contact us.  We may ask you to send us
a copy of a file that can be read by that software package for
comparison.

Please contact us even if you are just using an evaluation copy of
Alchemy.  In addition to helping fix a bug, we feel the best way
to get you to purchase a copy of Alchemy is to demonstrate how
committed we are to customer support.
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How to contact us Our address and phone numbers are:

Handmade Software, Inc.
48860 Milmont Road, Suite 106
Fremont, CA  94538

1 800 252 0101 (Toll-free from within the U.S.)
+1 510 252 0101 (Voice)
+1 510 252 0909 (Fax)

The most efficient way to contact us is by e-mail; this is
especially true if you can send us a sample file which
demonstrates the problem you are having.  Please enclose a short
note with your name and phone number so that we may call you
if we need further information.  Our e-mail address is:

email:  support@handmadesw.com

216          Image Alchemy



E

Binary Information Files (BIF)

Overview Binary files are files which are just image data.  In other words,
they do not contain any information other than the actual pixels
in the image file.  In order to read these files you must create a
file using a text editor which describes to Alchemy the format of
the file you are trying to read.  This is called a BIF file (and
typically has the extension .bif).

Required
information

At the minimum a BIF file needs to contain the name of the
image data file and either the height or the width of the image.
Alchemy will make assumptions about the other characteristics
of the image based on the information that it is given and the
total length of the image file.

The first line contains the letters BIF, which identifies the file as
a BIF file.

Each of the rest of the lines in the BIF file consist of an
information tag followed by the information.  The spelling of the
tags must be exact or Alchemy will report an unknown tag error.
The usage of many of the tags may not be entirely clear from the
description, please see the examples section if the usage of a tag
needs more explanation.

BIF file format
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Tags

Tag Description

filename The name of the file containing the image data.

To read images that consist of separate files for the red, green,
and blue data, repeat the filename tag three times.  The first
filename tag specifies the red data file, the second blue, and the
third green.  You must also specify both the height and width and
the number of planes in the image (which must be three) when
using three filename tags (ordinarily Alchemy can calculate one
tag from the others).  See below for an example.

The width of the image data, in pixels.width

The height of the image data, in pixels.height

The number of planes of image data:
1:  gray-scale
2:  gray-scale with an alpha channel
3:  RGB
4:  RGB with an alpha channel.

You can read a black and white image which consists of packed
data (i.e. 8 pixels per byte) by specifying 1 bitspersample (see
below for more information on the bitspersample).  In this case
you must also specify both the height and width of the image
(ordinarily Alchemy can calculate one from the other).  See
below for an example.

planes

The size of the header, in bytes.  This many bytes are skipped
when reading the file.

header

The number of bytes to remove from the beginning of each scan
line.

leftpadding

The number of bytes to remove from the end of each scan line.rightpadding
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order The order of the pixels:
For 1 channel g (g=gray).
For 2 channel images either ga or ag (a=alpha).
For 3 channel images, any sequence of r, g, and b:  rgb, rbg, grb,
gbr, brg, or bgr (r=red, g=green, b=blue).
For 4 channel images, any sequence of a, r, g, and b (a=alpha).

The defaults are g, ga, rgb, and rgba, depending on the number
of planes.

interleave The type of interleaving of the pixel data:
0:  Byte interleave RGBRGBRGBRGBRGBRGB…
1:  Line interleave RRR…GGG…BBB…RRR…GGG…BBB…
2:  Plane interleave RRRRRR…GGGGGG…BBBBBB…

The default is 0, Byte interleave.

upsidedown The presence of this tag indicates that the data in the file is
recorded from the bottom of the screen up to the top of the
screen.

The format of the data:
group4:  use Group IV Fax decompression

Currently the only format tag supported is Group IV Fax
compressed data (other standard formats will be added in future
versions of Alchemy).  See below for an example of reading a
Group IV compressed data file using a BIF file.

format

Options which affect decompressing fax compressed data:
bitreversal:  most significant bit first

This tag allows you to specify various fax options when reading
Group IV Fax compressed data.  Currently the only faxoptions
tag supported is bitreversal (other options will be added in future
versions of Alchemy).

faxoptions
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bitspersample The size of the data, in bits per sample:
1: 1 bit per sample (8 pixels per byte)
8: 8 bits (one byte) per sample
16: 16 bits (two bytes) per sample

The default is 8 bits per sample.

In the case of 1 bit per sample, it indicates that data is packed,
8 pixels being stored per byte (in which case the bitorder tag
determines whether the data is MSB to LSB or LSB to MSB (see
bitorder, below)).

8 bits per sample is the standard way of storing data, with one
byte storing one pixel.

16 bits per sample is used when reading data which is stored as
two bytes per pixel.  In this case Alchemy automatically scans
the data to determine the minimum and maximum values.  Then,
when the image is being read,  the data is scaled to 8 bits.  The
16 bits per sample value can be used for 2-bit to 16-bit data, as
long as the data is padded to 2 bytes.  By default, 16-bit data is
presumed to be unsigned and Motorola byte ordered (see signed
and byteorder, respectively, below).

bitorder The bit ordering in a 1 bit per sample (packed) image:
msblsb:  Most significant byte first
lsbmsb:  Least significant bit first

The default is msblsb (most significant byte first).

This option lets you specify the bit ordering when reading 1 bit
per sample data.
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byteorder The byte ordering in a 16 bits per sample image:
motorola:Motorola byte ordered (most significant byte first)
intel:Intel byte ordered (least significant byte first)

The default is Motorola byte ordered.

This option lets you specify the byte ordering when working
with 16 bit per sample data.

signed The presence of this tag indicates that the data is signed.  By
default, it is assumed that 16 bit per sample data is unsigned.

Comments Lines beginning with a # are treated as comments.  Comments
and blank lines are ignored when processing the BIF file.

If the binary file has a palette available, you can use that palette
by writing your own software to convert it to an HSI Palette file
and using the false color option while reading the BIF file.

Palette files
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Examples

Using a BIF file After creating a BIF file with a text editor, open that file as you
would any other image file.

Standard BIF files This is an example BIF file which can be used to read a 640
pixel wide, true color HSI Raw file.  Note that HSI raw files
have a 32 byte header which is being skipped.  Also note that the
height tag is not needed.  Alchemy will automatically calculate
the height based on the length of the file and the other tags.

Of course you could read the Raw file directly using Alchemy,
but this is after all an example of a BIF file.

BIF
width    640
#skip past header
header    32

filename  sample.raw
planes     3

#the tags below aren't actually needed,
#since rgb and non-interleave are
#the default, but they are included
#here to give an example of what those
#tags look like

order       rgb

interleave    0
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This example shows how to read an image which is plane
interleaved (i.e. all of the blue pixels are first, followed by the
green, and finally the red).

Plane Interleaved

BIF
filename  planar.img
width     1024
height    1024
channels     3
interleave   2
order      bgr

This is an example BIF file which would be used to read a
512x512 RGB file which has each of the different color pixels in
a separate file.  Note that the width, height, and planes tags must
all be present to read a file of this type:

Separate RGB files

BIF
filename  image.red
filename  image.grn
filename  image.blu

width    512
height   512
planes     3
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This is an example BIF file which would be used to read a black
and white image which is packed at 8 pixels per byte.  Note that
the width, height, and bitspersample tags must all be present to
read a file of this type (the bitorder tag is not necessary in this
case, since msb-lsb is the default order, but it is included because
we figured you were curious what that tagged looked like):

Packed black and
white data

BIF
filename  scan.img

width         2700
height        3300
bitspersample    1
bitorder    msblsb

This BIF file can be used to read a page of Group IV compressed
patent data as distributed by the United States Patent and
Trademark Office:

Group IV Fax
compressed

BIF
filename  4456956.001
width     2320
height    3408
channels     1
format       group4
faxoptions   bitreversal
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16 Bit Data You can use BIF files to read 16 bit data; only 8 bits of data will
actually be read, but Alchemy will automatically scale the data to
preserve the most information possible.  This BIF file can be
used to read a 1024 x 1024 image which is 16 bit, Intel byte
ordered:

BIF
filename      lunar.dat
width         1024
height        1024
channels         1
bitspersample   16
byteorder    intel
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F

HSI Raw Files

History The HSI Raw format was originally an internal format to Image
Alchemy.  Because of user demand the format has been
documented to allow others to read and write HSI Raw files.

Overview HSI Raw files are completely uncompressed, unpacked, and
unpadded image data files.  Therefore they tend to be larger than
almost any compressed file format.  However, they have the
advantage, as far as Alchemy is concerned, that they are very fast
to read and write and the location of any pixel in the image may
be found by simple calculations.

If you need to convert custom files to a format that Alchemy can
read we recommend using a Raw file; it is the simplest format to
write and the fastest for Alchemy to read.

There are two types of HSI Raw Files:  paletted and true color.
Paletted images are stored one byte per pixel with a palette at the
beginning of the file.  True color files are stored three bytes per
pixel.

Variations

Gray scale files are stored as paletted files with a palette that
contains all gray values.  Alchemy automatically recognizes such
files during reading and will treat them appropriately.

Gray-scale

Black and White files are stored as paletted files with a palette
that contains two values, black and white.  Alchemy
automatically recognizes such files during reading and will treat
them appropriately.

Black and white
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Warning Note that Handmade Software, Inc. reserves the right to make
changes to this format at any time and without notice.  And while
it is unlikely, it is possible that future versions of Image
Alchemy will not support this format.

Old version files This appendix describes version 4 Raw files.  This is the version
that Image Alchemy has written since March 1991.  Before this
Alchemy wrote version 2 and 3 raw files (version 2 were 8 bit
files, version 3 were 24 bit files).  Those raw files can be read by
current versions of Image Alchemy but are not otherwise
supported.  If you run across any of these raw files the easiest
thing to do is to use a current copy of Alchemy to convert them
to a version 4 raw file.

Details

All values which are not otherwise identified are two byte
integers (16 bits).  This is the native integer size of most IBM PC
C-compilers but not Macintosh and UNIX C-compilers.

Word size

All integers are stored high byte first (big-endian order).  This is
the native mode for Macintosh's and Sun's but not the native
mode for IBM PC's.

Byte order

See below for a CPU independent method to read and write 2-
byte integers.

Paletted files are stored one byte per pixel.

True color files are stored as three bytes per pixel in red, green,
blue order.

Pixel format
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Padding Neither the palette information nor the pixel data is padded to
anything other than a byte boundary.  This means that if you
store a file which is 13 by 11 pixels it will occupy 429 bytes if
stored as a true color file (not including the header), or 143 bytes
if stored as a paletted file (not including the header and palette
data).

Hex Numbers including a 0x prefix are hex; all other numbers are
decimal.

File format The header for a paletted file is 32 bytes plus the size of the
palette.  The header for a true color file is exactly 32 bytes (a true
color file contains no palette).

Six bytes used to identify the file as an HSI Raw file:Magic number

0x6d 0x68 0x77 0x61 0x6e 0x68

An integer used to identify the version HSI file:Version

0x0004

An integer indicating the width of the image (in pixels).Width

An integer indicating the height of the image (in pixels).Height

An integer indicating the number of entries in the palette.  Range
is 2 to 256.  A 0 or -24 indicates a true color image (which has
no palette data).

Palette size

An integer indicating the horizontal resolution of the image, in
dots per inch.  A zero indicates that the resolution is unknown.
A negative number is used if only the aspect ratio is known.

Horizontal DPI
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Vertical DPI An integer indicating the vertical resolution of the image, in dots
per inch.  A zero indicates that the resolution is unknown.  A
negative number is used if only the aspect ratio is known.

Gamma An integer indicating the gamma of the image, scaled by 100 (a
gamma of 2.2 is stored as 220).  A zero indicates that the gamma
is not known.

Compression An integer indicating the compression mode used to write the
file.  Currently only compression mode 0 is supported, but you
should check this value when reading a HSI Raw to make sure
that we have not added any compression modes.

Ten bytes reserved for future use.  Should be set to zero when
writing.

Reserved

The palette data is stored as 3 bytes per palette entry.  The bytes
are in red, green, blue order; 0 is black, 0xff is full intensity.

True color raw files have no palette.

Palette

The image data.Image data

Example files

6D 68 77 61 6E 68 00 04  01 40 00 C8 01 00 00 00
00 00 00 00 00 00 00 00  00 00 00 00 00 00 00 00
49 24 24 24 00 00 00 00  00 DB 6D 6D FF 92 92 FF
B6 B6 92 49 49 FF DB DB  FF B6 92 FF FF DB FF DB
B6 FF FF FF B6 6D 6D 6D  24 24 DB 92 6D 6D 49 49
…

8 bit paletted,
320 x 200:
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24 bit true color,
320 x 200:

6D 68 77 61 6E 68 00 04  01 40 00 C8 00 00 00 00
00 00 00 00 00 00 00 00  00 00 00 00 00 00 00 00
49 24 24 49 24 24 49 24  24 49 24 24 49 24 24 49
24 24 49 24 24 49 24 24  49 24 24 49 24 24 49 24
24 49 24 24 49 24 24 49  24 24 49 24 24 49 24 24
…

Reading a two
byte integer

unsigned int getWord(int i, FILE *stream) {
register unsigned int temp;
temp=(unsigned int) (getc(stream)<<8);
if (temp&0x8000)

temp|=~0xffff;
return(getc(stream) | temp);

}

int putWord(unsigned int i, FILE *stream) {
putc(i>>8, stream);
return(putc(i&0xff, stream));

}

Writing a two byte
integer

Image Alchemy           231



232          Image Alchemy



G

PAL Files

Overview PAL files are text files which contain a palette in an ASCII form.
Alchemy can extract palettes from other file formats and write
PAL files.  Alchemy can also use PAL files when converting
images.

File format The first line contains the letters "PAL"; this identifies the file as
a palette file.

The next line contains an integer indicating the number of palette
entries.  Valid values are 2 through 256.

The rest of the file consists of lines of 3 numbers, representing
the red, green, and blue values for each of the colors.  These
have a range of 0 (black) to 255 (full intensity).  Those three
numbers can be followed by a word instructing Alchemy what to
do with that entry.  The choices are "dontUse", "use", and
"replace".  dontUse causes Alchemy to leave that entry alone,
and not to map the image to it.  "use" is the default; Alchemy
will not change the values, and it will map  the image to it.
"replace" instructs Alchemy to replace the entry with a color
generated based on the image data, and then to map the image to
it.
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Example
PAL
8 ;# colors
  0   0   0 ;black
255   0   0 ;bright red
  0 128   0 ;dark green
255 255   0 ;yellow
  0   0 255 ;blue
255   0 255 ;magenta
 63  63  63 ;gray
255 255 255 ;white
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Acknowledgments

Summary Almost all the software which comprises Image Alchemy was
written in house.  However some of the modules are
modifications of software originally written by other people or
software that we have licensed.

TIFF Image Alchemy's TIFF I/O is based on libtiff which is copyright
by Sam Leffler and is used with his permission.  If you are
interested in reading or writing TIFF files we strongly suggest
that you start with libtiff.

Libtiff is available by anonymous ftp at ftp.sgi.com.

If you cannot get a copy of libtiff via anonymous ftp please
contact us for a free copy.

The LZW compression method is the subject of United States
patent number 4,558,302 and corresponding foreign patents
owned by Unisys Corporation and the use of it for GIF and TIFF
LZW compression is licensed from them.

Further information on licensing this patent can be obtained
from:

Unisys Corporation
Welch Licensing Department
Office of the General Counsel
M/S C1SW19
Blue Bell, PA  19424

LZW Compression
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Glossary

Anonymous FTP An easy way to transfer files via the Internet.  If you do not have
Internet access you can not use anonymous FTP; if you do have
Internet access you probably already know about it (if you do
not, ask your system administrator or local network guru).

Black and white An image which contains just two colors, black and white.
Many file formats, such as TIFF and Sun Raster, have special
variations for black and white images.  You can force Alchemy
to write a black and white image by specifying -b -c2 as options.

A technique for reducing the amount of color banding in an
image when converting from a large number of different colors
to a small number of different colors.  Different dithering
techniques are usually named after the person or persons who
first invented them.  Alchemy supports Floyd-Steinberg, Stucki,
and JJN dithering; these are further described in "Digital
Halftoning", by Robert Ulichney, MIT Press.

Dithering

An image which contains just shades of gray.  Many file formats,
such as TIFF and Silicon Graphics, have special variations for
gray-scale images.  You can force Alchemy to write a gray-scale
image by specifying -b -8 as options.

Gray-scale
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Header The portion of an image file that is not the actual image data.
The data in a header generally includes the image size (in
pixels), the image depth (in number of bits per pixel or number
of colors), and the palette (if the image has a palette).  Some file
formats include quite a bit of additional data in the header, such
as:  the name of the image or the date and time the image was
created.  Some file formats store information which is usually
found in the header in a separate file.

Heckbert color
quantization

A technique for reducing the number of colors needed by an
image, typically used to convert a true color image to a paletted
image.  Named after Paul Heckbert who originally described the
technique in "Color Image Quantization for Frame Buffer
Display", SIGGRAPH '82 Proceedings, p. 297.

Magic Number A number or sequence of numbers that is found at or near the
start of an image file so that software may determine what type
of format the file is.  Most formats have a well defined magic
number; some formats do not, in which case Alchemy examines
various parameters in the header of the file and guesses what
format the image is.

An image which is not true color.  Each pixel in the image is an
index into a table of values (typically red, green, and blue) which
describe the color of that pixel.  Most paletted images are limited
to 8 bits of information, which allows 256 unique colors.  Most
display adapters only allow the display of paletted images
(Alchemy can display true color images on those display
adapters by using a uniform palette).

Paletted

An image which does not contain a palette.  Each pixel in the
image is represented by at least three values, typically red, green,
and blue.  True color images are generally produced by scanners
and digitizers and are better quality and much larger than
paletted images.  Most display systems cannot display true color
images.

True color
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Colophon

This manual was created using Microsoft Word on a Macintosh..
The body text is set in Times Roman and the chapter and section
headings are set in Gill Sans.

Image Alchemy           243



244          Image Alchemy



Index

Extensions
.g8 47
.gif 69

.a 87 .gm 36

.a8 47 .goes 71

.art 65 .grb 79

.asc 79 .hdr 131

.avs 39 .hrf 73

.b8 47 .hst 49

.bif 41 .ibg 109

.bil 131 .ico 103, 152

.bmp 32, 102, 150 .icon 135

.c4 90 .idc 46

.cal 44 .idx 133

.ccrf 43 .img 28, 67, 86, 87, 129, 148

.cel 97 .imq 109

.clr 131 .jpg 93

.crf 43 .lan 60

.ct 89, 124 .lbm 84

.dcx 108 .mac 99

.doc 83 .miff 100

.eps 52 .mtv 101

.ers 58 .p 87

.fal 117 .p13 106

.fax 63 .pal 50, 80

.fbm 64 .pat 142

.flc 34 .pbm 112

.fop 66 .pcd 96
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.pcj 106 .xbm 154

.pcl 74 .xim 156

.pcx 106 .xpm 157

.pdf 29 .xwd 160

.pgm 112
Numbers.pic 35, 82, 105, 111

.pict 98 15 bits 171

.png 114 16 Bit 225

.pnm 112 16 bit GA 171

.ppm 112 16 bits 171

.pre 133 24 bits 171

.prn 33, 43, 62, 76, 88 32 bit CMYK 171

.psd 31 32 bit RGBA 171

.puzzle 116 4 bit CMYK) 171

.q0 117
A.qdv 119

.r8 47 Acknowledgments 235

.rast 136 Acrobat 29

.raw 81, 120 ADEX 28

.rg 121 Adobe Acrobat PDF 29

.rgb 117 Adobe Photoshop 31

.rla 149 Adobe Systems 29, 31, 53

.rlc 123 Agfa Corporation 125

.rle 143 Aldus Corp. 140

.rtl 78 Alpha Microsystems 32

.scd 125 Alps 33

.scx 122 Amiga 84

.sgi 128 Anonymous FTP 237

.sst 37 ANSI 205

.tab 133 Append 22

.tga 138 Apple Computer 98, 99

.tiff 140 AppleTalk 198

.vi 91 ART 65

.vif 145 Aspect 185

.viff 146 Aspect ratio 185

.vit 147 Autodesk Animator FLC 34

.wpg 153 Autodesk PIC 35

246          Image Alchemy



Autologic 36 Color 207, 240
AVHRR 37 Color banding 209
AVS X 39 Color cube 207
Axis 198 Color quantization 172

B
ColorSync 177
Commodore-Amiga Corp. 84

Batch processing 18 Compression 21
Bayer 174, 175 CompuServe 69
Bennett 116 Contrast 182
BIF 40, 217 Conversion 20
Binary Information Files 40, 217 Convolutions Directory 14
Bitorder 220 Convolve 180
Black and white 237 Copy 165
Blackstock 119 Core 46
Blur 180 Core Software Technology 46
BMP 32, 102, 150 Coy 148
Bottom 187 Crop 185, 187
Bridges 105 Cubicomp 47
Brightness 182 Cumulative Histogram 49, 197
Byteorder 221 Custom Applications 66

C
Customer Support 215
Custom… 173

CADCore 73 CUT 50, 165
Calcomp 42

DCALS 44
CCIR-601 94, 212 DCX 108
CCITT RLE 140 Default Magnification 13
CCRF 42 Defense Logistics Agency 44
CD 10918-1 94 Deluxe Paint 84
CEL 97 Department of Defense 44
ChromaGraph 28 DesignJet 24 bit 77
Chrominance 212 DesignJet 24 bit alternate dither 77
Clear 165 DesignJet 3 bit 77
Close 161 DesignJet 4 bit 77
CMYK extensions 56 Device independent preview 52
Collage Raster 45 Digital Research 67
Colophon 243 Direct color 207
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Discrete cosine transform 212 First Publisher 65
Disk space 3 FLC 34
Display Images 12 Floyd-Steinberg 174
Dither 174 Fonts Directory 14
Dithering 207, 209, 237, 240 Freedom of Press 66
DLA 44 FTP 237
DoD 44

GDot gain 199
Dr. Halo 50 Gamma 182, 199
Dynamic Hi-Res 84 GARS 71

E
GEM 67
Get File Info 12

Earth Resource Mapping 58 Get Info for Current File 12
Edge Detection 180 GIF 69
Edit 165 GIF89A 69
EGA Palette 174 Giffer 119
Email iii, 216 Gill Sans 243
Encapsulated PostScript 51 GIS 131
Enlarge 191 Glossary 237
EPS 51 GOES 71
Epson Stylus 57 Graphic Object 79
Equalization 183 Graphics Parameter Block 36
ER Mapper 58 GRASP 105
Erdas 60 Gray-scale 205, 237
Error diffusion 174, 209, 210 GROB 79
Execute Script 195 Group 4 raster 44
Export 23 Group III 77, 140
Extensions 27 Group IV 140, 224

F H

Fargo Primera 62 Halftone 174, 175
Fax 224 HALO Desktop Imager 50
Fax board 108 HAM 84
FaxModem 63 Header 238
FBM 64 Heckbert 172, 238, 241
File 17, 161 Heckbert' 209
File Formats 240 Height 185, 187
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Hewlett-Packard 74 Invert 175
Hewlett-Packard Company 79 Iris 89
High Speed Interface inline 36 ISO 205
Histogram 183

JHitachi Raster Format 73
Hitachi Software Engineering Co., Ltd. 73 Jarvis, Judice & Ninke 174
HLS 32 JEDMICS C4 90
HP LaserJet 74 JFIF 93, 203, 212, 214
HP PCL 74 Joint Photographic Experts Group 93, 211
HP PhotoSmart 76 Jovian VI 91
HP RTL 77 JPEG 93, 202, 203, 204, 205, 211, 241
HP-48sx 79 JPEG File Interchange Format 214
HP7600 77 JPEG Interchange Format 213
HRF 73

KHSI Palette 80
HSI Raw 81, 227 Kodak PhotoCD 96
Huffman 93, 94, 213 Korn 120

I L

IBM 82, 102, 103 LAN/GIS 60
IDC 46 Lanczos 186
Identifying image files 25 Landscape 74
IDIDAS 37 LaserJets 74
IDRISI 83 Leffler, Sam 235
IEC 205 Left 187
IFF 84 Level 1B AVHRR 38
IGS 73 Libtiff 235
ILBM 84 Lossy compression 211
Image Scaling 241 Lumena 97
Imaging Technology 86 Luminance 212
Img Software Set 87 LZW 235
IMGMAP 37

MImport 19
Input Options 19 MacBinary 25
Interchange File Format 84 Macintosh 98
Intergraph 88 MacPaint 99
InterLeaved BitMap 84 Magic number 25, 238
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Matrix Instruments Inc. 125 PaintJet 77
McIDAS 71 PAL Files 233
Media Cybernetics 50 Palette 80, 171
Median cut 209 Paletted 207, 238
Menus 6 Paste 165
Microsoft Corp. 140, 150, 152 PBM 112, 113
MIFF 100 PC Paint 107
Millions 171 PCJ 106
MIT 154, 157, 160 PCL 74, 203
MTV Ray Tracer 101 PCPAINT 104, 105
Multiple Operations 8 PCX 106, 108

N
PDF 29, 242
PDS 109

NASA 109 Perturbation 175
Nearest neighbor 186 PGM 113
NESDIS 37, 71 Photoshop 31
NetQue 198 PICT/PICT2 98
NOAA 37, 71 Pictor 104
Noise 210 Picture Maker 82
Non-Planar 77 PictureMaker 47
NovaJet 77 Pixar 111

O
Pixel data 40
Planar 77

On the Fly 77 Plug-ins Directory 14
Open Dialog Box 19 Portable BitMap 112
Open Several 18 Portable Document Format 29, 242
Optimal palettes 209 Portable Network Graphics (PNG) 114
Options 12 Pose 191
OS/2 102, 103 Poskanzer 112
OS/2 Bitmap 102 PostScript 53, 66, 242
OS/2 Icon 103 PPM 113
Overview 3 Print 162

P
Printer Command Language 74
Profile… 176

Packbits 77, 140 Publisher's Paintbrush 107
Packed 224 PUT 72
Page Setup 161 Puzzle 116
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Q
Send to Device… 24
Serpentine 174, 210

Q0 117 Set Magnification 191
QDV 119 Set Resolution 183
QRT Ray Tracer 120 SGI 128
Quantization 213 Sharp GPB 129
Quit 162 Sharpen 180

R
Show Image 191
Sierra Lite 174

Raster Graphics 121 Signed 221
Raster Transfer Language 77 Silicon Graphics Image 128
Raveling, Paul 87 Software Publishing Corp. 65
Raw 41, 81 Spaceward Graphics 130
Record Script 195 Spiff 183
Reduce 191 SPOT Image 131
References 239 SSTMAP 37
Required equipment 3 Stevenson and Arce 174
Resize 185 Stork 133
Revert to Saved 161 Storyboard Live 82
Right 187 Stucki 174
RIX 122 Sub-sampling 212
RIX Softworks 122 Sun Icon 135
RLC 123 Sun Microsystems 135, 136
RLE 128, 150 Sun Raster 136
RTL 77

TRun length coded 130, 133, 138
Run length compression 136 Tagged Interchange File Format 140, 200
Run Script Upon Opening Image 13 Targa 138, 198

S
The Edit Menu 165
The Image Menu 169

Satellite 37 Thousands 171
Save Preview Image 13 TIFF 140, 200, 235
Scaling 185, 186 Tiff class B 201
Scan Font Files 15 Tiff class G 201
Scitex 124 Tiff class P 201
Scodl 125 Tiff class R 201
Scripts Directory 13 TIFF Preview 52
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Time Arts 97 Windows Bitmap 150
Times Roman 243 Windows Icon 152
Top 187 WordPerfect Graphic File 153
Topic 145

XTrue Color 207, 238
Truevision 138 X Windowing System 116, 154, 157, 160

U
XBM 154
XIM 156

Uncompressed 77 XPM 157
Undo 165 XWD 160
Uniform 172 XY format 160
Uniform palettes 208

YUnisys 235
Units 13 YCbCr 94, 212
University of Michigan 143

ZUniversity of Utah 143
University of Wisconsin 71 Z format 160
US Patent 142 ZSoft 106, 107, 108
Use Default Name 27
Use Gamma 182
Utah Raster Toolkit 143
Utah RLE 143

V

Variations 22
VDI Image File 67
Verity Image Format (VIF) 145
VI 91
VIFF 146
VITec 147
Vivid 148

W

Warranty ii
Wavefront RLA 149
Width 185, 187
Windows 150, 152
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